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Introduction 1

Introduction
Congratulations and thank you for purchasing the SL-5500 Personal Mobile Tool.

We recommend that you first read the separate Start-up Guide (which mainly covers 
setup procedure, hardware operations, and common and basic software operations) 
before using the SL-5500 unit. Then read this Operation Manual (which mainly 
covers software operations).

Some of the accessories described in this manual may not be available at the time 
you purchase this product.

Copyright
It is the intent of Sharp that this product be used in full compliance with the copyright 
laws of the United States and that prior permission be obtained from copyright 
owners whenever necessary.
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2 Introduction

About this manual
The SL-5500 can be operated by either pressing keys on the keyboard or tapping 
an item (buttons, etc.) on the screen using the stylus.

• This operation manual mainly describes the stylus operation. Button or key 
operations are included, if they make it easier to carry out the function.

Keys
This manual represents keys with the following:

Screen Buttons and Menu Names
Screen buttons and menu names, such as “OK”, “File”, “Edit”, etc., are indicated 
using quotation marks.

 

 

: HOME key

: Cancel key

: OK key

: Cursor key

: Left cursor key

: Right cursor key

: Up cursor key

: Down cursor key

SELECT key
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Address Book 3

Address Book
The Address Book application allows you to manage contact information on friends, 
colleagues, etc. covering the items shown below.
You can also add notes to help you remember contacts more easily.

Overview 
The Address Book application has three major screens: Edit Address screen, Index 
screen, and Detail screen.

New/Edit Address screen
1. In the Applications folder of the Home screen, tap the “Address Book” 

application icon.

The Index screen appears.

2. Tap .

The New Address screen appears.

You can create a new Address Book entry.

“Notes...” button
Tap to attach a note.

00.Cover.book  Page 3  Monday, January 21, 2002  5:47 PM



4 Address Book

<Address fields>      

First Name First name
Last Name Last name
Category Category (Tap the drop-down list button.)
Middle Name Middle name
Job Title Title
Department Department in the office
Company Company name
Work Phone Work Phone Number
Work Fax Work Fax Number
Work Mobile Business Mobile phone number
Emails E-mail addresses
Home Phone Home phone number
Home Fax Home Fax Number
Home Mobile Personal Mobile phone number
Work Street Work Address
Work City Work City
Work State Work State
Work Zip Work zip code
Work Country Country of the office
Work Pager Work pager-number
Work Web Page Company URL
Home Street Street Address
Home City Home City
Home State Home State
Home Zip Home Zip Code
Home Country Home Country
Home Web Page Home URL
Spouse Spouse’s name
Birthday Birthday
Anniversary Anniversary
Nickname Nickname
Gender Gender (Select from the drop-down list.)

00.Cover.book  Page 4  Monday, January 21, 2002  5:47 PM



Address Book 5

Note:

• An Address Book entry can not be saved if only the Gender field is filled out. 
• You can enter multiple e-mail addresses in the Emails field by inserting a 

comma between them. Each e-mail address entered can be used as an e-mail 
address in the EMail application.

Index Screen
A list of existing names and contact details is displayed.

Note:

• If you have no entries in the First Name, Last Name or Middle Name field, the 
entry for the Company field will be displayed in the Full Name column instead. 
If there is no entry in the Company field, the first e-mail address in the Emails 
field will be displayed instead. 

• To find the desired entry in the Full Name column, Contact column, Company 
column, press the first few characters in the each column on the hardware 
keyboard. The focus moves to the matching column.

Category name Indicates the category name of the entries listed.
“Full Name” button Tap to sort the entries by full name.
“Contact” button Tap to sort the entries by contact data.
“Company” button Tap to sort the entries by company.

Data area

Displays the contents of the entry.
Full Name column displays the First Name, Last 
Name and Middle Name.
Contact column displays the first entry listed under 
the First Name, Last Name, and Middle Name fields. 
(except for “Company” field)
Tap this field to open the Detail screen of the entry.

“Contact” button

Data area

“Full Name” button

H: Indicates Home Phone 
or Home Mobile.

W: Indicates Work Phone 
or Work Mobile.

“Company” button

Category name
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6 Address Book

Detail Screen
1. On the Index screen, tap an entry to see the full address details. 

Or move the focus to the entry by using  and then press the SELECT key.

Note: To switch the screens between the Index and Detail screen, press the 
Address Book key on the slider cover.

Creating a new Address Book entry
You can add a new address using the New Address screen.

1. On the Index or Detail screen, tap .

The New Address screen for a new entry appears.

2. Enter the contact data in the fields.

Pressing the tab key on the hardware keyboard moves the cursor to the next 
entry field.
Pressing the shift-tab keys moves the cursor to the previous entry field.

Note:

• Tap the “Notes...” button to attach a note. (See page 7.)
• If you want to assign one or more category names, see the separate Start-up 

Guide for details.

3. Tap  to save the new entry.

The New Address screen returns to the Index screen.

If you tap , the new entry is canceled.
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Address Book 7

Modifying an Address Book entry

1. On the Index screen, move the focus to the entry you want to modify. 
Or open the Detail screen.

2. Tap .

The Edit Address screen appears.

3. Tap each field and modify the entry.

Note: Tap the “Notes...” button to attach a note. (See below.)

4. Tap  to save the modification.

The Edit Address screen turns to the Index screen.

If you tap , the modification is canceled.

Attaching a Note
You can enter a note to go with the address.

1. On the New Address or Edit Address screen, tap the “Notes...” button.

The Enter Note screen appears.

2. Enter the note and tap  to save it.

The Enter Note screen returns to the Edit Address screen.
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8 Address Book

If you tap  on the Enter Note screen, the attached note is canceled.
To save the entry with a note attached, tap   on the New Address or Edit 
Address screen.

Deleting an Address Book entry

1. On the Index screen, move the focus to the entry you want to delete. 
Or open the Detail screen.

2. Tap , or tap the “Data” menu and then tap “Delete...”.

The confirmation message appears before the entry is deleted.

If you want to delete all entries from the Address Book application, tap the 
“Data” menu and then tap “Delete all...”.

3. Tap “Yes” to delete the entry.

The entry will be deleted.

If you tap “No”, the deletion is canceled.

Address Book Setup 
The New Address or Edit Address screen always shows the First Name and Last 
Name fields at the top. You can change the order of the following fields except for 
the Category and Gender fields.

1. On the Index or Detail screen, tap the “Options” menu, then tap “Field 
Settings...”.

The Field Settings screen appears, and the fields following the Category field 
are listed in current order.

“Up” button
“Down” button
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Address Book 9

2. Tap the field you want to move.

3. Tap the “Up” or “Down” button (or press and hold  and then press  or ) 
to move the selected field upwards or downwards to the desired position. 

4. Tap  to save the setting.

The Field Settings screen returns to the previous screen.

Your setting will be displayed following the Category field on the New Address 
or Edit Address screen.

If you tap , the setting is canceled.

Registering/Editing your personal 
information (My Personal Details)

1. On the Index screen, tap the “Data” menu and then tap “My Personal Details…”.

My Personal Details screen appears.

2. Tap  and then enter your information on Edit My Personal Details screen that 
appears.

Note: On the Personal Detail screen, you cannot enter the category name.

3. Tap  to save the setting. 

My Personal Details screen appears listing your information. 

4. Tap the “Data” menu and then tap “My Personal Details…”.

The display returns to the Index screen.

Note: Your personal information registered after FULL reset will be displayed 
on the My Personal Detail screen of step 1 above. (See the separate 
Start-up Guide, “Registering your personal information”.)
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Calendar 11

Calendar
The Calendar application is used to store events you are keeping track of and to set 
alarms. For this application to work properly, the built-in clock must be set to the 
correct time and date.

Overview
You can view one day, one week or one month at a time. Tap the “View” menu, then 
select “Day”, “Week” or “Month”.
There are also toolbar icons,  (day),  (week) and  (month), for switching 
views.
By selecting “Today” from the View menu, you can display the Day screen for today.

Day screen
1. In the Applications folder of the Home screen, tap the “Calendar” application 

icon.

Day icon Displays the Day screen.
Week icon Displays the Week screen.
Month icon Displays the Month screen.
Previous button Moves to the previous date.

Date button Opens/closes the Calendar screen to select 
the date.

Day icon

Month icon

Previous button

Day of week buttons

Next button

Week icon

Date button

Time indication
Event indication 
(Focused status)
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12 Calendar

Week screen

Day of week buttons Switches the day of the week.
Next button Moves to the next date.

Time indication
Displays the time.
Tap or drag this field and tap  to open the 
New Event screen with the Start and End time 
entered.

Event indication
(Focused status)

Displays the registered events.
 : Events with Alarm setting
 : Repeating events

Press  or  to move the focus.
Then press the SELECT key or  to open 
the Detail screen.

Year spinbox
Select the year.
Tap  to move to the next year, and tap   
to move to the previous year.

Week spinbox
Select the week.
Tap  to move to the next week, and tap   
to move to the previous week.

Date indication Displays the start and end date of the selected 
week.

Time column Displays the time.

Day of week buttons Tap to open the Day screen of the selected 
day.

Year spinbox

Week spinbox

Time column
Day of week buttons

The currently focused 
initial is displayed in 
blue.

Date indication

Event  indication
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Month screen

Event indication

Tap to display the detailed contents of the 
event.
Green bar: All day event
Red bar:     Event with an Alarm setting
Blue bar: Event with Start and End time     

setting
Press  or  to move the focus between 
days of the week. Then press  or the 
SELECT key to open the Day screen.

To January button Moves to January of the selected year.
Previous button Moves to the previous month.
Month drop-down list 
button

Select the desired month.

Year spinbox
Select the year.
Tap  to move to the next year, and tap   
to move to the previous year.

Next button Moves to the next month.
To December button Moves to December of the selected year.

Date cell

Tap to open the Day screen of the date.
Colored events mean:
Red box: Event with an Alarm setting
Blue box: Event with Start and End time 

setting
: Repeating event
: All day event

Focus frame
Press  to move the focus. Then press 

 or the SELECT key to open the Day 
screen.

To January button

Previous button

Year spinbox

Next button

Month drop-down
list button

To December button

Date cell

Focus frame
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14 Calendar

Detail Screen

Adding Events

1. In any view mode screen of the Calendar application, tap .

The New Event screen appears.

2. Select/Enter the event contents.

• For Description and Location, you can either select from the list, or enter your 
own. 

• Select the desired category from the drop-down list. (“Unfiled” is the default) You 
can add more category names. See the separate Start-up Guide for details.

• You can change the time zone by tapping the City Time button. (See page 77, “To 
change to other cities”)

• You can set an event alarm. (See page 15, “To set an alarm”)

Detailed information
Tap  or press  
to close the Detail 
screen.
The display returns to the 
Day screen.

Alarm sound on/off 
drop-down list button
Repeat button
Notes field

All day checkbox
Start/End date buttons

Time zone drop-down
list button

Alarm checkbox

Start/End time comboboxes

City Time button
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Calendar 15

• You can make a repeating event. (See below, “To repeat an event”)
• You can enter a note in the Notes field.

3. Tap  to save the new event entry.

The New Event screen turns to the previous screen.

If you tap , the new event is canceled.

Note: No event will be saved, if no items are entered in the Description, 
Location, or Notes field.

To set the Start and End date/time
1. On the New Event screen, tap the Start date or End date button.

The Calendar screen appears.

2. Tap the desired date.

3. Tap the Start time or End time combobox.

4. Select the desired time, or change it by using the keyboard.

You can mark an event as taking “All day” by tapping the All day checkbox.

To set an alarm
1. On the New Event screen, check the Alarm checkbox.

2. Set the amount of time prior to the event when you would like the alarm to ring.

3. Tap the alarm sound on/off drop-down list button, and select “Silent” or “Loud”.

• The alarm will ring and the Alarm screen will appear at the set time, even if the 
SL-5500 is off.  (Tap “OK” to close the Alarm screen.)

• The alarm will not ring with the following settings:
• The alarm setting is “Silent”.
• The Mute checkbox is checked, or the Alarms checkbox is unchecked. (Tap 

the Sound volume icon on the taskbar.)

To repeat an event
1. On the New Event screen, tap the Repeat button.

The Repeating Event screen appears.
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16 Calendar

2. Tap the appropriate repetition button for the event, i.e. “Day”, “Week”, “Month”, 
or “Year”.

If you do not want to repeat the event, tap the “None” button.

3. Enter the necessary information. (See page 16 and 17 for details.)

4. Tap  to save the repeat setting.

The Repeating Event screen returns to the New Event screen.

If you tap , the repeat setting is canceled.

Daily Events 

1. Tap the Every spinbox to set how many days between each repeat.

2. If the event has an end date, uncheck the No End Date checkbox, then tap the 
End Date button, and choose an end date from the calendar that pops up.

Weekly Events 

1. Tap the Every spinbox to set how many weeks between each repeat.

Repeating Event screen 
(Day)

Every spinbox

No End Date checkboxEnd Date button

Repeating Event screen 
(Week)

Repeat On buttons
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Calendar 17

2. If the event has an end date, uncheck the No End Date checkbox, then tap the 
End Date button, and choose an end date from the calendar that pops up.

3. To choose which day(s) of the week the event should repeat, tap the relevant 
Repeat On button(s).

Monthly Events 

1. Tap the Every spinbox to set how many months between each repeat.

2. If the event has an end date, uncheck the No End Date checkbox, then tap the 
End Date button, and choose an end date from the calendar that pops up.

3. If the event repeats by day of week (i.e. every first Thursday), tap the Repeat By 
“Day” button. If the event repeats by date (i.e. every 6th), tap the Repeat By 
“Date” button.

Annual Events 

1. Tap the Every spinbox to set how many years between each repeat.

2. If the event has an end date, uncheck the No End Date checkbox, then tap the 
End Date button, and choose an end date from the calendar that pops up.

Repeating Event screen 
(Month)

Repeat By buttons

Repeating Event screen 
(Year)

No End Date checkbox
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18 Calendar

Modifying a Calendar event

1. On the Day screen, tap and hold the entry you want to modify. 

The popup menu appears. 

2. Select “Edit event”.

Or on the Detail screen, tap  instead of performing steps 1 and 2.

The Edit Event screen appears.

3. Modify the event.

4. Tap  to save the modification.

The Edit Event screen turns to the previous screen.

If you tap , the modification is canceled.

Note: If you modify a repeating event, all of other occurrences of this repeating 
event are modified accordingly. 

Deleting Calendar event entries

Deleting a Calendar event entry
1. On the Day screen, tap and hold the entry you want to delete.

The pop-up menu appears.

2. Select “Delete”.

Or on the Detail screen, tap  instead of performing steps 1 and 2.
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Calendar 19

The confirmation message appears before the entry is deleted.

3. Tap “Yes” to delete the entry.

The entry will be deleted. 

If you tap “No”, the deletion is canceled.

Note: If you delete a repeating event, all of other occurrences of this repeating 
event are deleted accordingly. A single repeating event cannot be 
deleted. 

Deleting the Daily, Weekly, or Monthly events
You can delete the daily, weekly, or monthly events (except for repeating events) at 
a time.

1. Open the view mode screen (Daily, Weekly, or Monthly) on which you want to 
delete events.

2. Tap the “Data” menu and then tap “Delete period...”.

3. On the screen that appears, tap the drop-down list button and then tap the 
specified item as follows:

For the daily events, tap “Events in selected day”.

For the weekly events, tap “Events in selected week”.

For the monthly events, tap “Events in selected month”.

4. Tap “Yes”.

The confirmation message appears before the entry is deleted.

5. Tap “Yes” to delete the entry.

The entry will be deleted. 

If you tap “No”, the deletion is canceled.

Deleting all Calendar event entries
1. In any view mode of the Calendar application, tap the “Data” menu and then tap 

“Delete all...”.

The confirmation message appears before the entry is deleted.

2. Tap “Yes” to delete all entries.

All entries will be deleted. 

If you tap “No”, the deletion is canceled.
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20 Calendar

Calendar Setup 
You can change the starting time on the Day screen and Week screen, and the 
Alarm setting.

1. On the view mode screen (Daily, Weekly, or Monthly), tap the “Options” menu, 
then tap “Alarm and Start Time...”.

The Alarm and Start Time screen appears.

2. Tap the Start Time spinbox to set the earliest time you want the Day Screen/
Weekly screen to show times.

3. Check the Alarm Preset checkbox to set the Alarm Preset time.

4. Tap the Alarm Preset spinbox to change the preset time.

If you set the preset time to “5 minutes”, for example, the alarm sounds five 
minutes before the event.

This setting will be the default alarm setting on the New Event screen.

5. Tap  to save the setting.

The Preferences screen turns to the previous screen.

If you tap , the setting is canceled.

Start Time spinbox

Alarm Preset spinboxAlarm Preset checkbox
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Todo List
The Todo List application allows you to manage tasks you should not forget and 
reminds you to complete them before the due date.
You can list them in the order of the checked status, the priority or description, and 
confirm them easily.

Overview
On the Todo List Index screen, you can view a list of Todo entries.

Index screen
1. In the Applications folder of the Home screen, tap the “Todo List” application 

icon.

Note: The past-due uncompleted entries will be displayed in red.

Checked status button Tap to sort the entries by checked status 
(completed or uncompleted).

Completed checkbox When unchecked, the task is not completed 
and when checked, the task is completed.

Priority button Tap to sort the entries by priority.
Description button Tap to sort the entries by description.
Due Date button Tap to sort the entries by due date.

Checked status button

Description button

Completed checkbox

Priority button
Due Date button
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22 Todo List

Detail screen
1. On the Index screen, tap the desired entry.

Edit screen 

Detailed information
Tap  to close the 
Detail screen.
The display returns to 
the Index screen.

Priority drop-down list button

Due date checkbox

Due Date button
Displays the due date 
if the Due date 
checkbox is checked.
Tap to open the 
Calendar screen.

Category drop-down 
list button

Text field

Completed checkbox

Edit Categories button
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Todo List 23

Creating a new Todo List entry

1. On the Index or Detail screen, tap .

The New Task screen appears.

2. Tap the Priority drop-down list button and select the priority.

3. Tap the Category drop-down list button to set the task’s category. You can also 
enter a desired category name. For details, see the separate Start-up Guide.

4. If the task has a due date, check the Due date checkbox.

5. Tap the Due Date button and then tap the due date from the pop-up Calendar 
screen.

6. Tap the text field and enter the task, etc.

7. Tap  to save the new entry.

The New Task screen turns to the Index screen.

If you tap , the new entry is canceled.

Priority drop down list 
button

Tap to display the candidate of the properties and then 
tap your choice.

Category drop-down 
list button

Tap to display the candidate of the properties and then 
tap your choice.
If you want other category name, tap the Edit 
Categories button. (For details, see the separate Start-
up Guide.)

Edit Categories button Tap to display the Edit Categories screen where you 
can edit categories or assign multiple categories to an 
event. (See the separate Start-up Guide for more 
details.)

Completed checkbox Check if the task has been completed.

Due date checkbox Check it off if the task is due to be completed on a 
specified date, and then tap the Due date button next 
to the checkbox.

Due date button Tap this button to specify the due date if the Due date 
checkbox has checked.

00.Cover.book  Page 23  Monday, January 21, 2002  5:47 PM



24 Todo List

Modifying a Todo List entry

1. On the Index screen, tap and hold the Description field of the entry you want to 
modify.

The pop-up menu appears.

2. Select “Edit task”.

Or move the focus to the entry you want to edit and tap  instead of performing 
steps 1 and 2.

The Edit Task screen appears.

3. Modify the entry.

Check the Completed checkbox if the task is completed.

4. Tap  to save the modification.

The Edit Task screen turns to the Index screen.

If you tap , the modification is canceled.

Note: The Task status and priority can also be changed on the Index screen. 
(See below.)

Completed checkbox
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Todo List 25

Deleting Todo task entries

Deleting a Todo task entry
1. On the Index screen, tap and hold the Description field of the entry you want to 

delete.

The pop-up menu appears.

2. Select “Delete”.

The confirmation message appears before the entry is deleted.

Or move the focus to the entry you want to delete and tap  instead of performing 
steps 1 and 2.

3. Tap “Yes” to delete the entry.

The entry will be deleted. 

If you tap “No”, the deletion is canceled.

Deleting all Todo task entries
1. On the Index or Detail screen, tap the “Data” menu and then tap “Delete all...”.

The confirmation message appears before the entry is deleted.

2. Tap “Yes” to delete all entries.

All entries will be deleted. 
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26 Todo List

Other functions

Checking a completed entry on the Index screen
When you have completed a Todo task, check the Completed checkbox on the 
Index screen. If you do not check the box, the Todo List entry is recognized as 
uncompleted.

1. On the Index screen, tap the Completed checkbox of the completed entry.

To remove the check, tap the Completed checkbox again.

Changing the priority on the Index screen
You can change the priority on the Index screen.

1. Tap the Priority field you want to change. 

The Priority drop-down list button appears.

2. Tap the Priority drop-down list button and select the priority.

To view only the uncompleted entries
1. On the Index screen, tap the “Options” menu and then tap “View”.

2. Tap “Hide completed tasks”.

Only uncompleted entries will be displayed. 

To toggle between completed and uncompleted tasks, tap the “Options” menu 
and then tap “View”. 
Then tap “Show completed tasks” or “Hide completed tasks”.
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Text Editor
The Text Editor application allows you to create a simple text file and open a file in 
a text format and edit it. The text files are displayed in the “Documents” folder of the 
Home screen. 

Overview
The Text Editor application has two main screens: Text Editor Index screen and Edit 
Text screen.

Index screen
1. In the Applications folder of the Home screen, tap the “Text Editor” application 

icon.

The Text Edit Index screen appears. 

The Text Editor Index screen displays a list of text files you can open.

Note: To find the desired text file, press the first few characters of the file name 
on the hardware keyboard. The focus moves to the matching file.
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Edit screen
1. Tap  to create a new entry.

The New Text screen will be displayed.

The created file will be automatically named with the first character(s) (up to 40) 
entered before the first space.

File menu
Save Saves the current file.

Edit menu
Undo Undoes the last operation. 
Redo Cancels the Undo operation to restore the status before the Undo 

operation is done.
Cut Cuts selected text to the clipboard.
Copy Copies selected text to the clipboard.
Paste Pastes text within clipboard to cursor position.

View menu
Zoom in Makes the display font size larger.
Zoom out Makes the display font size smaller.
Bold Changes the character type to bold.
Italic Changes the character type to italic.
Wrap lines The carriage return is inserted into the text according to the width 

of the screen.

Edit area

Edit menu

Edit area

File menu

View menu
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Creating a new Text Editor entry

1. Tap  to create a new entry.
Or tap the “File” menu and then tap “New”.

The New Text screen will be displayed.

2. Enter text using one of the Input Methods. 

3. Tap  to save the new file.

If you tap , saving the file is canceled.

Modifying a Text Editor entry

1. On the Text Editor Index screen, tap the file you want to edit.
Or tap the text file icon you want to edit in the Documents folder of the Home 
screen.

The Edit screen will be displayed

2. Edit the file.

3. Tap  to save the modification.

If you tap , the modification is canceled.

The display returns to the Text Editor Index screen.

Deleting a Text Editor entry

1. On the Index screen, move the focus to the file you want to delete.

2. Tap the “File” menu and then tap “Delete...”.

The confirmation message appears before the file is deleted.

3. Tap “Yes” to delete the file.

The file will be deleted.

If you tap “No”, the deletion is canceled.
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Renaming the Text Editor file

1. On the Index screen, move the focus to the entry you want to rename.

2. Tap the “File” menu and then tap “Rename...”.

The Rename screen appears.

3. Modify the current file name.

4. Tap  to save the new name.

If you tap , the modification is canceled.
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Media Player
The Media Player application allows you to play MPEG1 video files and MP3 music 
files. You can also transfer files from a PC using PC link software.

Note:

• Use a headphone connected to the stereo headphone jack of the unit to listen 
to the media sound.

• Some files (such as MP3 music files of MPEG2.5 format) can not be played 
back with this application.

• The Media Player application may close automatically if multiple applications 
are running simultaneously.

• The media image may be distorted and the sound may be interrupted during 
playback if other programs are running simultaneously.

• Do not insert or remove the memory card during playback.
• For detailed information on how to attach and remove the memory card, see 

the separate Start-up Guide.

Overview
The Media Player application has three folders on the Index screen: Video, Music, 
Playlist.
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Index screen

The Media Player application has three folders on the Index screen: Video, Music, 
Playlist.

1. In the Applications folder of the Home screen, tap the “Media Player” application 
icon.

The Index screen appears.

Video folder Tap to display only the video files.
Music folder Tap to display only the music files.
Playlist folder Tap to display the files registered in the playlist.
File List area Displays the files (mpg, mpeg, mp3) which are registered 

in the Documents folder of the Home screen and on the 
memory cards inserted into the slots. 

Play button Tap to start playback.
“Add to playlist” 
button

Adds a file to a Playlist folder.

Up button Moves up the selected file in the playlist.
Down button Moves down the selected file in the playlist.
“Remove from 
playlist” button

Removes a file from a Playlist folder.

Video tab

Music tab

Size button
Media button
Title button

Play button

Remove from 
playlist button

Playlist tab

File List area

Add to playlist button

Up button 
(for Playlist)

Down button 
(for Playlist)
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Note:

• To find the desired file, press the first few characters of the file name on the 
hardware keyboard. The focus moves to the matching file.

• You can copy files stored on a memory card to the Documents folder by using 
the Copy function on the Documents Details screen (see the separate Start-
up Guide).

Playback screens
The Playback screen varies depending on the type of file being played.

1. On the Index screen, tap the file you want to play and then tap , or press 
 or the SELECT key.

• To close the playback screen, press  or the SELECT key again.
• To close the application, tap , or press .

Title button Tap to sort files by title.
Media button Tap to sort files by storage media (CF, SD, RAM)
Size button Tap to sort files by size.
File menu

Play Plays the file in the Video, Music, or Playlist folder.
Info… Displays the file information.
Add to playlist Adds a file to the Playlist folder.
Up Moves up the selected file in the playlist.
Down Moves down the selected file in the playlist.
Remove from 
playlist

Removes a file from the Playlist folder.

View menu (used to play video files)
Fullscreen Switches the screen mode, full screen, or normal screen.
Scale Makes the image fit the screen.

Options menu
Repeat Repeats playback of the file in the Video, Music, or Playlist 

folder.
Random Plays files in the Playlist folder at random.
Help... Opens the on-line Help screen.
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For movie files    

• If you tap on the screen, the display turns to the Index screen.  

Press When pressed after 2 seconds after a file begins, the current 
file will be played again from the top. When pressed within 2 
seconds, the previous file will start playback.
When only one file or the first file in the list is being played in 
the once mode, stops the playback, and returns to the Index 
screen.

Press Moves to the next file.
When only one file or the last file in the list is being played in 
the once mode, stops the playback, and returns to the Index 
screen.

Press Tap and hold to turn the volume up step by step.
Press Tap and hold to turn the volume down step by step.

Normal mode Fullscreen mode
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For music files

<Playback Control>

Note: The volume control in the Media Player application also affects the 
volume setting of the SL-5500.

(Play) Plays the current file from the top or resumes playback if 
paused. When tapped during playback, restarts playback 
from the top of the current file.

(Stop) Stops playback.
(Pause) Pauses playback.

Tap again to resume the playback.
(Open) Stops playback, and returns to the Index screen.
(Repeat) Switches the playback mode (Repeat or Once).

If you have selected the Repeat mode from the Options menu 
on the Index screen, this button will already have been 
pressed.

(Previous)
(Press )

When tapped (pressed) after 2 seconds after a file begins, the 
current file will be played again from the top. When tapped 
(pressed) within 2 seconds, the previous file will start 
playback.
When only one file or the first file in the list is being played in 
the Once mode, stops the playback, and returns to the Index 
screen.

(Next)
(Press )

Moves to the next file if the music file is being played.
When only one file or the last file in the list is being played in 
the Once mode, stops the playback and returns to the Index 
screen.

(Volume Up)
(Press )

Tap and hold to turn the volume up step by step.

(Volume Down)
(Press )

Tap and hold to turn the volume down step by step.

Playback control buttons

Current playback time/
total playback time

File information
File name,
artist name,
sampling rate, 
etc.
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Playing a file
This section describes an example of playing files stored on a memory card. Before 
playing files, insert the memory card into the appropriate card slot of the SL-5500.

To start playback
1. On the Index screen, tap the Video or Music tab.

All files stored in the SL-5500 and memory card will be displayed according to 
the file type to be played.

2. Tap the desired file in the list.
And then tap  or press  or the SELECT key.

The selected file will be played.

The playback screen varies according to the file type to be played. 

To stop playback
1. Press  or the SELECT key, the playback will be stopped and the screen 

will return to the Index screen.

Or while the music file is being played, tap . 

Setting the Repeat mode
1. On the Index screen, tap the “Options” menu and then tap “Repeat”.

The file will be played repeatedly. The files in the Playlist folder will be all played 
repeatedly.

To cancel the Repeat mode, repeat step 1.
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Playing a file in the Playlist
By registering the video or music files in the Playlist, you can play them in the 
registered order or in random sequence. 
This section describes an example of playing files stored on a memory card. Before 
playing files, insert the memory card into the appropriate card slot of the SL-5500.

Adding files to the Playlist
1. On the Index screen, tap the Video or Music tab.

All files stored in the SL-5500 and memory card will be displayed according to 
the file type to be played.

2. Tap the desired file in the list.

3. Tap the Add to playlist button ( ). 
Or tap the “File” menu and then tap “Add to playlist”.

The same file name of the selected file will be registered to the Playlist folder.

Tapping the Playlist tab allows you to confirm it.

4. Repeat steps 1 to 3 above, if necessary, to register multiple files. 

Arranging the file order in the Playlist
Once you have registered files in the Playlist, you can change the file order 
(playback order).

1. Tap the Playlist tab.

2. Tap the file you want to move.

3. Tap  or .

The selected file will move upwards or downwards. 

Deleting files from the Playlist
1. Tap the Playlist tab.

2. Tap the file you want to delete.

3. Tap the Remove from playlist button ( ). 
Or tap the “File” menu and then tap “Remove from playlist”.

The selected file will be deleted immediately.
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To playback files in the Playlist folder
1. Tap the Playlist tab.

2. Tap  or press  or the SELECT key.

All files in the Playlist folder will be played once from the top of the list, and 
playback will stop automatically.

Note: If the Repeat mode is selected in the Options menu, all files in the 
Playlist folder will be played repeatedly.

To stop playback
1. Press  or the SELECT key, the playback will be stopped and the screen 

will return to the Index screen.

Or while the music file is being played, tap .

To playback at random
1. Tap the Playlist tab.

2. Tap the “Options” menu and then tap “Random”.

All files in the Playlist folder will be played at random. 

To cancel the Random mode, repeat step 2.
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Other functions

Displaying the file information
1. Tap the “File” menu and then tap “Info…”.

The file information screen will be displayed. 

The following appears depending on the file type (video or music)
• Picture size, Frame rate, etc. (video)
• Sampling rate, Channel, etc. (music)

2. Tap  or  to close the slip.
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Image Viewer
The Image Viewer application allows you to see image files such as JPEG, GIF, 
BMP, PNG, XBM, and XPM.
You can transfer files from a PC using PC link software.

Note:

• Large image files will not be able to be viewed due to memory constraints.
• Some files can not be viewed with this application.
• For detailed information on how to attach and remove the expansion memory 

card, see the separate Start-up Guide.

Overview
The Image Viewer opens with a list of images (Index screen).

Index screen
1. In the Applications folder of the Home screen, tap the “Image Viewer” 

application icon. 

File menu

Options menu

File List area
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Note:

• To find to the desired file, press the first few characters of the file name on the 
hardware keyboard. The focus moves to the matching file.

• You can copy files stored on a memory card to the Documents folder by using 
the Copy function on the Documents Details screen (see the separate Start-
up Guide).

Image view screen
1. On the Index screen, tap the image file you want to view.

The selected image appears on the screen.

File menu
Open… Opens the image file.

Options menu
Slideshow Slideshows all entries.
Preferences… Opens a preference screen for slideshow setting.
Help… Opens the on-line Help screen.

Title button Tap to sort files by name.
Type button Tap to sort files by file type.
Date button Tap to sort files by date.
File List area Displays the files that are registered in the Documents folder 

of the Home screen, and on the memory cards inserted into 
the slots. Tap a file to view the image file.

Rotate 180 icon Rotates the image by 180°.
Rotate 90 icon Rotates the image by 90° counterclockwise.

Image information

Rotate 180 icon

Rotate 90 icon

Full screen iconView menu

Options menu
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• Tapping  returns to the Index screen.

Viewing images

Viewing a single image
1. On the Index screen, tap the image you want to view.

The selected image will be displayed.
• Press  to display the next screen, or press  to display the previous 

screen.
• Tap on the image or press the SELECT key or  to switch the screen 

mode between Full screen and Normal screen.

2. Tap  or press  to return to the Index screen.

Slideshowing the file
1. Tap the “Options” menu and then tap “Slideshow”.

All files will be opened once from the top of the list in the Full screen mode. 
When the slideshow is finished, the display returns to the Index screen.

Full screen icon Displays the image on the full screen with no Menu bar or 
taskbar on it. Tapping the display or pressing the SELECT 
key or  returns to the Normal screen.

Image Information Displays the original image pixels, display image pixels, 
color information (and transparent colored file 
information, if available)

View menu
Horizontal flip Flips the image horizontally.
Vertical flip Flips the image vertically.
Rotate 180 Rotates the image by 180°.
Rotate 90 Rotates the image by 90° counterclockwise.
Fullscreen Displays the image on the full screen with no Menu bar or 

taskbar on it. Tapping the display or pressing the SELECT 
key or  returns to the Normal screen.

Options menu
Slideshow Slideshows all entries.
Preferences… Opens a preferences screen for slideshow setting
Help… Opens the on-line Help screen.
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• If the Auto-play option is unchecked, the first file on top of the list will be 
opened. (For information on the Auto-play option and others, see below.)

• If you press  with the Auto-play option unchecked, the next file will be 
opened. If you press , the previous file will be opened. 

• The View menu settings (Rotate, etc.) will not be effective for the Slideshow 
command.

To stop the slideshow, press . The display returns to the Index screen.

To set up the slideshow preferences
1. Tap the “Options” menu and then tap “Preferences...”.

2. Set up the desired preferences.

3. Tap  to save the setting.

Slideshow setting
Auto-play 
checkbox

If checked, files will be automatically opened.

Repeat checkbox If checked, files will be automatically opened repeatedly.
Delay time slider If the Auto-play option is checked, move the slider to adjust 

the delay time with which the next file will start.

Delay time slider

Repeat checkbox
Auto-play checkbox
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Opera Browser
The Opera Browser application allows you to browse the Internet.
To browse the Internet, you must set up the communication method (modem card, 
LAN card, etc.) and network preferences.

Note:

• The Opera Browser application has no capability to save pages and 
embedded images.

• Exiting the application clears the cache without saving it in a file.
• Some Web pages (including font setting, etc.) can not be displayed or not 

displayed correctly in this application.
• Some graphical images of larger size may not be displayed.
• While browsing the Web pages, you can check incoming e-mail messages.

Overview

Browsing screen
1. In the Applications folder of the Home screen, tap the “Opera Browser” 

application icon.

   

Back icon

Reload icon
Forward icon

Security Status icon
Zoom icon
Web page address icon

Bookmark list icon

Help icon

Preferences icon
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Security Status 
icon

Displays security information. 
If the page you access uses the SSL protocol, etc., the 
Security Status icon changes to the locked state with a set  
security level. Tap the icon to display the security level 
description.

Back icon Returns to the previous page. Tap and hold to list recently 
displayed pages (tap again to close) and then tap any list item 
to display the page.

Reload icon Displays the latest update of the page. When the page data is 
being downloaded, the Stop icon is displayed instead.

Forward icon Re-displays the page displayed before you tapped the “Back” 
icon. Tap and hold to list recently displayed pages (tap again to 
close) and then tap any list item to display the page.

Preferences icon Displays the screen to set up the homepage to be displayed at 
startup, together with security level. 

Bookmark list icon Displays the Bookmark list screen. Tap again to close.
Web page 
address icon

Displays a Web page address screen for entering a URL, 
adding to bookmarks, or searching for a Web page. Tap again 
to close.

Zoom icon Displays a menu to specify the setting of the display (tap again 
to close). Choices: Tiny, Small, Medium, Large, Huge

Help icon Displays a help screen.
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Browsing the Web page

Operations on the Web page including frames
If the Web page you opened includes a frame, use the “Use top” or “Use bottom” 
button.

Opening the specified Web page
1. Tap the Web page address icon ( ).

The Web page address screen will be displayed.

Use top button Tap to fit the upper frame in window.
Use bottom button Tap to fit the lower frame in window.

Frame

Use top button

Frame

Use bottom button

Web page address field
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2. Enter the desired Web page address beginning with “http://”.

3. Tap “Go”.

The specified Web page will be displayed.

Registering the Web page address in the bookmark list
1. Display the desired Web page.

2. Tap the Web page address icon ( ).

The Web page address screen will be displayed.

3. Tap “Add to bookmarks”.

The Edit Bookmark screen will be displayed. 

Usually, Web page address field will contain the address of the latest 
successfully loaded Web page.

4. Modify the bookmark name and the Web page address, if necessary, and then 
tap “OK”. 
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Using the Search function
Search allows you to find the specific character strings using the search engine you 
select. 

1. Tap the Web page address icon ( ).

The Web page address screen will be displayed.

2. Tap the Search engine drop-down list button and then tap the desired search 
engine.

3. Enter the string you want to search for in the Search field displayed below the 
button.

4. Tap “Search” or press .

The search result will be displayed.

Using the bookmarks
1. Tap the Bookmark list icon ( ). 

The Bookmark list screen will be displayed.

Search field
Search engine drop-down list 
button
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Displaying the bookmarked page using bookmarks
1. On the Bookmark list screen, tap the “Go” radio button and tap the desired 

bookmark.

The selected Web page will be displayed.

Deleting the bookmark
1. On the Bookmark list screen, tap the “Del” radio button and then tap the desired 

bookmark.

A confirmation message appears.

2. Tap “Yes” to delete the bookmark.

If you tap “No”, the deletion is canceled.

Editing bookmarks
1. On the Bookmark list screen, tap the “Edit” radio button and then tap the desired 

bookmark you want to edit.

Go radio button Displays the page selected in the bookmark list.
Del radio button Deletes the bookmark selected in the bookmark list.
Edit radio button Displays the Edit Bookmark screen.
Move radio button Allows you to change the order by dragging the item in the 

Bookmark list.
Bookmark list Lists all the addresses you have registered (bookmarked).

Go radio button
Del radio button
Edit radio button

Bookmark list

Move radio button
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The Edit Bookmark screen will be displayed. 

2. Edit the Web page address and Web page name, as you want.

3. Tap “OK” to save the modification.

If you tap “Cancel”, the modification is canceled. 

Changing the bookmark order
1. On the Bookmark list screen, tap the “Move” radio button.

2. Drag the desired bookmark in the Bookmark list to change the order.

Setting up the Opera Browser preferences
1. Tap the Preferences icon ( ).

The Preferences screen will be displayed. 

Web page address field

Page Name field

Home page field

Cookies checkbox

Security checkbox
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2. Tap "OK" to save the settings.

Home page field Enter the address of the homepage that will be 
displayed every time you launch the Opera Browser 
application.

Cookies checkbox When checked, only the information you entered or 
selected on the Web page will be saved to disk. The 
cookie will be sent back the next time when the SL-
5500 browses the same Web page. 

Security checkbox (Protects the page displayed with the SSL technology.)

Enable SSL v2 Tap to enable the SSL v2 option.

Enable SSL v3 Tap to enable the SSL v3 option. 

Enable TLS 1.0 Tap to enable the TLS 1.0 option. 

Issue security 
warnings

Tap to display a warning message when you move 
between the safe and unsafe Web site
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EMail

Overview
The EMail application allows you to send and receive e-mail messages.
The EMail application features:

• POP3/SMTP/IMAP4 protocols
• Multiple e-mail accounts
• Converts attachment files using the MIME format
• The Mail light (LED) flashes for an e-mail receipt
• Refers to the Address Book application to import e-mail addresses, and registers 

the e-mail addresses of the e-mail you received in the Address Book application.
• Sorts the e-mail messages by queries you create
• Groups e-mail messages by mailboxes you create

To send and receive e-mail messages, you must:

• Set up the communication method (modem card, LAN card) and network 
preferences

• Set up an e-mail account in the EMail application 

Index screen

1. In the Applications folder of the Home screen, tap the “EMail” application icon.

Caution: Be sure to check that enough memory storage space (the text size of 
the created message plus 10 Kbyte or more) is secured before 
exiting the EMail application because the EMail application needs to 
save the data being edited in the work area.

Note: The EMail application may have a delayed launch depending on the 
saved quantity of data.
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The EMail Index screen has four folders.

Folders folder Browses the Inbox, Outbox, and Sent folders in the tree 
format.

Inbox folder Displays the received e-mail messages.
Unread messages will be displayed in blue. Messages that have 
been read will be displayed in black. Messages whose titles only 
have been downloaded will be displayed in red. (See page 65.)

Outbox folder Displays the e-mail messages you have created. The unsent 
e-mail messages are displayed in red. 

Sent folder Displays the sent mail logs. (The original messages will be 
saved in the Outbox folder.) 

Folders

Mail menu
Options menu

Outbox Sent

Delete icon

Sort by 
query 
button

Edit mail icon

Reply to 
mail icon

Send mail icon
Get all mail icon
New mail icon

Inbox
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Send mail icon Sends all unsent e-mail messages in the Outbox.
Get all mail icon Receives all e-mail messages that are saved in the mail 

server.
New mail icon Opens a screen to create a new e-mail message. 
Reply to mail icon Opens a reply mail screen for the sender only.
Sort by query 
button

Tap to sort e-mail messages by query you create. (See page 
71.)

Delete icon Delete the selected e-mail message. 

Mail menu
Send all mail Sends all unsent e-mail messages in the Outbox.
Get all mail Receives all e-mail messages that are saved in the mail 

server.
Get mail in Receives the e-mail messages in the selected account.
Cancel transfer Cancels e-mail transfer.
New mail Opens a screen to create a new e-mail message.
Edit mail Opens an existing e-mail message to be edited.
Reply to mail Opens a reply mail screen for the sender only.
Reply to all Opens a reply mail screen for all senders and receivers.
Forward mail Opens a screen to forward the received e-mail message.
Delete mail Deletes the selected e-mail message.
Delete selected Deletes the e-mail message displayed on the Examine 

screen, when checked. (See page 68.)
Options
New account Opens the New account screen. (See page 58.)
Edit account Opens the Edit account screen displayed in the submenu.
Delete account Deletes the selected account displayed in the submenu.
Font Changes the display font size.
New query Opens the New query screen. (See page 70.)
Edit query Opens the Edit query screen.
Delete query Deletes the selected query.
New mailbox Creates a new mailbox. (See page 73.)
Rename mailbox Renames the mailbox.
Delete mailbox Deletes the mailbox.
Move to Moves the e-mail messages to the folder displayed in the 

submenu. 
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Note: To move the focus to the desired entry on the Folders, Inbox, Outbox or 
Sent screen, press the first few characters of the e-mail message or 
folder name using the hardware keyboard.

Examine (Detail) screen
1. On the Index screen, tap an e-mail message.

Select for delete 
checkbox

Deletes the e-mail massage displayed on the Examine 
screen, when you select “Delete selected” from the Mail 
menu.

Previous icon Displays the previous message.
Next icon Displays the next message.
Send mail icon 
(Outbox)

Sends the e-mail message displayed on the Examine 
screen.

Reply to mail icon 
(Inbox)

Opens a reply mail screen for the sender only.

Attachments icon Opens an attached list screen on which to open, save the 
attachment file, move it to the expansion memory card, etc. 
(see page 67.)

E-mail message

Mail menu

View menu
Select for delete checkbox Previous icon

Send mail icon
Attachments icon

Next icon

(Outbox)
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2. Tap  to close the Detail screen and return to the Index screen.

New mail screen
1. On the Index screen, tap .

Mail menu
Get this mail
(Inbox)

Receives an e-mail message if its e-mail header has been 
already received.

Send this mail 
(Outbox/Sent)

Sends the e-mail message displayed on the Examine 
screen.

New mail Opens a screen to create a new e-mail message.
Edit mail Opens an existing e-mail message to be edited.
Reply to mail Opens a reply mail screen for the sender only.
Reply to all Opens a reply mail screen for all senders and receivers.
Forward mail Opens a screen to forward the received e-mail message.
Add to address 
book

Adds the e-mail address of the sender to the Address Book 
application.

Set status Changes the e-mail status between Sent and Unsent in the 
Outbox folder, or Unread in the Inbox folder.

Delete Deletes the e-mail message displayed on the Detail screen.
View menu

Previous Displays the previous message.
Next Displays the next message.
Attachments... Opens an attached list screen on which to open, save the 

attachment file, move it to the expansion memory card, etc. 
(see page 67.)

Text format Changes the view format between the text format and rich 
text format.
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E-mail accounts
The EMail application allows multiple e-mail accounts to be registered.

Note: If you have already registered e-mail accounts in the Internet Wizard 
application, they apply to the e-mail accounts for the EMail application. 
To configure detailed settings, tap the “Options” menu on the Index 
screen and then tap the account from the “Edit account” submenu. 
Detailed procedures are described below.

Setting an e-mail account
1. On the Index screen, tap the “Options” menu and then tap “New Account”.

The New Account screen will be displayed including two folders: Outgoing and 
Incoming.

Direction drop-down 
list button

Tap to select the e-mail direction (TO, CC, BCC).

Address Book icon When tapped, lists the e-mail addresses registered in the 
Address Book application. 

Attachment icon When tapped, lists the attachment files to be attached to the 
e-mail message. 

Mail menu
Send this mail Sends the e-mail message displayed.
Refer Address Book Lists the e-mail addresses registered in the Address Book 

application.
Adding Attachments Opens the screen to select the attachment files to be 

attached to the e-mail message.

Direction drop-down
list button

E-mail address field

Subject field

Address Book icon

Message area

Attachment icon
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2. Tap the “Outgoing” tab to set the sending options. 

Account name Enter the account name.

Your name Enter your name as used in the “From” field of the e-
mail message.

Email Enter your e-mail address.

SMTP server Enter the server name for sending e-mail messages.

SMTP port Enter the server port number for sending e-mail 
messages (default setting: 25).

Use signature checkbox Check to add a signature. On the screen that 
appears, enter the signature that is added to the end 
of the e-mail message. Tap  to save the 
signature.

Use signature checkbox
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3. Tap the “Incoming” tab to set the receiving options.

4. When you have finished settings, tap  to save them.

Choose account type 
drop-down list button

Tap to select the desired account type (POP, IMAP)

Username field Enter login name used to log in to an e-mail system.
Password field Enter password used to log in to an e-mail system.
Server field Enter name of the server used to receive e-mail messages
Port field Enter server port number for receiving e-mail messages. 

(default setting: 110).

Server settings
Synchronize 
checkbox

Check if you want to synchronize e-mail information with 
the server. Then you can download only new messages 
that the server has received.

Delete mail checkbox Check if you want to erase e-mail messages saved in the 
server after you have finished downloading messages.

Skip large emails 
checkbox

Check to specify an e-mail size limit.
When checked, the Email threshold screen is displayed. 
Tap and hold the slider to specify the maximum size of  
incoming e-mail messages. (range: 10 Kbyte to 1000 
Kbyte) Tap  to save the setting.
If you receive an e-mail message of a size larger than 
specified, only the message title (sender name, date and 
the size of the message) will be downloaded.

Choose account type 
drop-down list button 

Synchronize checkbox
Skip large emails

checkbox
Delete mail checkbox
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Editing the e-mail account
1. On the Index screen, tap the “Options” menu and then tap the desired account 

from the “Edit account” submenu.

2. Edit in the same way as you do on the New Account screen.

Deleting an e-mail account
1. On the Index screen, tap the “Options” menu and then tap the desired account 

from the “Delete account” submenu.

The confirmation message will be displayed.

2. Tap “Yes” to delete the account.

The selected account will be deleted.

Creating an e-mail message

1. On the Index screen, tap .
Or tap the “Mail” menu and then tap “New mail”.

The New mail screen will be displayed.

(E-mail account: From)
2. When registering multiple e-mail accounts, tap the Direction drop-down list 

button to select “From”.

3. Tap the e-mail address field to select the desired account.

(Recipient’s address: To, CC, BCC)

Direction drop-down
list button

E-mail address field

Subject field

Address Book icon

Message area

Attachment icon
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4. Tap the Direction drop-down list button to select To, CC, or BCC.

5. Enter the e-mail address in the E-mail address field.

• You can enter multiple e-mail addresses by inserting a comma between 
them.

• E-mail messages are saved as drafts in the Inbox folder, unless otherwise 
specified. 

• Tap the Address Book icon ( ) on the New mail screen. The e-mail 
addresses stored in the Address Book application will be listed. 

• Tap one or more desired addresses and then tap  (Check).
• Repeat steps 4 and 5 above to select multiple recipients.

6. Enter the subject and message.

(File attachment)
7. If you want to attach one or more files, tap the Attachment icon ( ) in the New 

mail screen.   

Note: File attachments should not be larger than 500 Kbyte.

Address Book icon
Attachment icon

Type drop-down
list button

Documents list

Attachment list
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8. Tap a file in the left Documents list, and then tap “Attach ->”.

The selected file will be listed in the right Attached list telling you that the file is 
attached to the e-mail message you are editing.

• You can tap the Type drop-down list button to narrow the category by 
switching the file types: “image”, “audio”, or “video”.

• If you want to remove the attachment, tap it in the right Attached list, and then 
tap “Remove”.

• If you send an e-mail message including an attachment on a memory card, 
leave the card in the card slot. If you remove the card, be sure to copy the 
attachment to the Documents folder using the Copy function of the 
Documents Details screen. (See the separate Start-up Guide.)

9. Repeat the steps above to complete selection.

10. Tap  to return to the Write mail screen.

11. Tap  to save the new mail.

The e-mail you created will be completed and added to the Outbox.

Checking e-mail contents
1. Tap the e-mail message of which you want to view the contents.

2. Tap  if you accept it.

If you want to modify it, tap the “Mail” menu and then tap “Edit mail”.

3. Edit the e-mail on the Edit mail screen that appears and then tap  .
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Sending an e-mail message

Sending all e-mail messages
1. In the Outbox folder, tap the “Mail” menu and then tap “Send all mail” 

Or tap the Send mail icon ( ).

2. All unsent e-mail messages will be sent.

The sent e-mail messages are displayed in black, the sent mail logs are saved 
in the Sent folder and the original messages are saved in the Outbox folder

Sending a single e-mail message
1. Tap the desired e-mail message in the Outbox folder.

The Examine screen appears.

2. Tap the “Mail” menu and then tap “Send this mail”. 
Or tap the Send Mail icon ( ) on the Examine screen.

3. The e-mail message will be sent.

The sent e-mail message is displayed in black, the sent mail log is saved in the 
Sent folder and the original message is saved in the Outbox folder.

Status button

: unsent e-mail
: draft e-mail

Displays the number of sent 
and unsent messages

Send mail icon
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Receiving e-mail messages

Receiving e-mail messages from all e-mail accounts
1. On the Index screen, tap the “Mail” menu and then tap “Get all mail”. 

Or tap the Get mail icon ( ) in the Inbox folder.

Note: If you receive an e-mail message of a size larger than specified, or the 
connection is terminated, only the message title (sender name, date, 
and the size of the message) will be downloaded. It is displayed in red 
with the down arrow on the Index screen of the Inbox folder. For 
information on maximum size settings, see page 60.

Receiving e-mail messages from one e-mail account
1. On the Index screen, tap the “Mail” menu and then tap “Get mail in”.

2. Tap the desired account.

Opening an e-mail message
1. On the Index screen, tap the desired e-mail in the Inbox folder.

The Examine screen of the received e-mail message will be displayed.

Reply to mail icon

Get mail icon

Displays the number of 
received and unsent 
messages

(purple): 
e-mail message
unread
: e-mail title having

no message
downloaded
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Replying to an e-mail message
You can reply only to the sender(s).

1. Tap “Mail” menu and then tap “Reply to mail”, or tap the Reply to mail icon ( ).

Replying to all
You can reply to all recipients and senders.

1. Tap the “Mail” menu and then tap “Reply to all”.

Forwarding an e-mail message
You can forward an e-mail message.

1. Tap the “Mail” menu and then tap “Forward mail”.

Registering the e-mail address of the sender 
in the Address Book application
You can register the e-mail address of the sender of the e-mail message you 
received in the Address Book application.

1. On the Index screen, tap the desired e-mail in the Inbox or Outbox folder.

The Examine screen will be displayed.

2. Tap the “Mail” menu and then tap “Add to addressbook”.
The Add to addressbook screen will be displayed.
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3. Tap the drop-down list button and then tap the e-mail address you want to add 
to the Address Book application.

4. Tap .
The selected e-mail address will be registered to the Address Book application 
and the display turns to the Index screen of the Address Book application. Edit 
it, if necessary.

Opening or arranging the attachment files
You can not only open the received attachment file, but copy it to the Documents 
folder of the SL-5500, and move it to the expansion memory card.

1. Tap the received e-mail message including an attachment file in the Inbox 
folder, etc.

The Examine screen will be displayed.

2. Tap the “View” menu and then tap “Attachments...”. 
Or tap the Attachments icon ( ).

The Attachments list screen will be displayed.

3. Tap the checkbox to select the attached file.

4. Tap the “Data” menu and then tap any of the following.

Open in (Application 
name)

Open the attachment file with a specified application.

Add to documents Copies the attachment file to the Documents folder of the 
SL-5500.

Move to card [SD] Moves the attachment file to the SD memory card, while 
deleting the original attachment file. (The e-mail message 
will remain.) 

Data menu

Attachment list
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5. Tap  to execute the selected command.

Deleting e-mail messages

Deleting an e-mail message
1. On the Index screen, move the focus to the e-mail message you want to delete. 

Or open the Examine screen of the e-mail message you want to delete.

2. Tap . 
Or tap the “Mail” menu and then tap “Delete mail” (“Delete”).

The confirmation message appears before the message is deleted.

3. Tap “Yes” to delete the message.

Note: If you delete the sent e-mail messages from either the Outbox or Sent 
folder, the original e-mail messages and their log files will be deleted 
from both folders. 

Deleting the selected e-mail messages
You can delete e-mail messages that appear in the Inbox, Outbox or Sent folders.

Move to card [CF] Moves the attachment file to the CF card, while deleting 
the original attachment file. (The e-mail message will 
remain.) 

Delete Deletes the attachment file while leaving the original e-
mail message.

Select all Select all attachment files in the Attachment list.
Deselect all Deselect the attachment files in the Attachment list.
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1. Open the Examine screen of the e-mail message you want to delete.

2. Tap the “Select for delete” checkbox. 

Note: You cannot check the “Select for delete” checkbox to delete unread or 
unsent e-mail messages.

3. Tap  to close the Examine screen.

The checked e-mail messages will be marked with a green circle ( ), and the 
folder including the messages will be displayed.

4. If you want to mark multiple e-mail messages, repeat steps 1 to 3. 

5. Tap the “Mail” menu and then tap “Delete selected”.

A confirmation message appears before the messages are deleted.

6. Tap “Yes” to delete them.

Select for delete 
checkbox
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Searching for an e-mail message
You can query the Inbox or Outbox  folders to search for a specific e-mail message.

Creating a new query
1. Tap the Folders tab to open the Folders folder.

2. Tap the desired folder (Inbox or Outbox).

3. Tap the “Options” menu and then tap “New query”.

The New query screen appears.

Search option drop-down list buttons
Mailbox Indicates the Inbox and Outbox folders to be queried.
Status 1 Specifies an e-mail by status:

Incomplete mail/complete mail for the Inbox folder,
Mail not sent/Mail sent for the Outbox folder

Status 2 Specifies an e-mail by status:
Read/Unread for the Inbox folder

Attachment Specifies an e-mail message by an attachment file:
No attachment/Attachment

Search option fields
From Enter a sender name.
Recipient Enter a recipient name.
Subject Enter an e-mail subject.
Body Enter a part of the e-mail message.

Search option drop-down list buttons
Mailbox, Status1,
Status2, Attachment

Name field

Search option fields
From
Recipient
Subject
Body

Search option checkboxes and 
Date button

after
before
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4. Set the query conditions for the e-mail message.

5. Tap  to save the setting.

The created queries will be displayed in step 2. 

Note: Tap-and-holding the Inbox or Outbox folder in step 2 will allow you to pop 
up a menu and create a new query.

To sort the e-mail message using query
1. Tap the desired folder tab: Inbox or Outbox.

2. Tap the Sort by query button.

The created queries will be displayed.

3. Tap the query you want to display.

The e-mail messages that meet the query conditions you selected appear.

• To display all e-mail messages in the folder, select “Inbox” or “Outbox” using 
the Sort by query button.

• Another way to sort the e-mail messages is as follows:
1. In the Folders folder, tap the desired query.
2. Select the Inbox or Outbox tab of the query.

The e-mail messages that meet the query conditions you selected appear. 

Search option checkboxes and Date button
after Specifies an e-mail by date. Tap to select the specified date 

after which the e-mail message has been received or sent.
before Specifies an e-mail by date. Tap to select the specified date 

before which the e-mail message has been received or 
sent.

Name field Enter the desired query name you can easily find.

Sort by query 
button
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To edit the query
1. In the Folders folder of the Index screen, tap the desired query you want to edit.

2. Tap the “Options” menu and then tap “Edit query”.

The Edit query screen appears..

3. Modify, as you want.

4. Tap  to save the modification.

Note: Another way to edit the query is as follows:
1. In the Folders folder, tap and hold the desired query.
2. Select “Edit query” in the menu that pops up.

To delete a query
1. In the Folders folder of the Index screen, tap the desired query to be deleted.

2. Tap the “Options” menu and then tap “Delete query”.

The confirmation message appears before the query is deleted.

3. Tap “Yes” to delete the query.

The selected query will be deleted.

Note: Another way to delete the query is as follows:
1. In the Folders folder, tap and hold the desired query.
2. Select "Delete query" in the menu that pops up.
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Using a mailbox folder in the Inbox/Outbox 
folder

Creating a new mailbox folder
This function allows you to create a new mailbox folder inside the Inbox or Outbox.

1.  Tap the Folders tab to open the Folders folder.

2. Tap the desired folder (Inbox or Outbox) in the Folders folder.

3. Tap the “Options” menu and then tap “New mailbox”.

The new mailbox folder will be created in the selected folder and will be named 
as “New mailbox”. 

You can rename it immediately or later, if necessary.

To rename a mailbox folder
You can rename the mailbox folder created in the Inbox or Outbox.

1. Tap the Folders tab to open the Folders folder.

2. Tap the desired mailbox folder to be renamed.

3. Tap the “Options” menu and then tap “Rename mailbox”.

4. Modify the folder name, as you wish.
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To delete a mailbox folder
You can delete the mailbox folder created in the Inbox or Outbox.

1. Tap the Folders tab to open the Folders folder.

2. Tap the desired mailbox folder to be deleted.

3. Tap the “Options” menu and then tap “Delete mailbox”.

A confirmation message appears before the mailbox is deleted.

4. Tap “Yes” to delete the mailbox folder.

The selected mailbox folder including its e-mail messages will be deleted.

Note:

• The default folders (“Inbox”, “Outbox” and “Sent”) cannot be renamed or deleted.
• To rename or delete a mailbox folder, tap and hold the desired mailbox instead of 

performing steps 2 and 3, and select “Rename mailbox” or “Delete mailbox” from 
the pop-up menu.

Moving an e-mail message to another folder
This function allows you to move e-mail messages saved in the Outbox, Inbox, or 
Sent folder to another folder in the same folder.

1. Open the desired folder (Inbox, Outbox, or Sent).

2. Move the focus to the e-mail message using .

3. Tap the “Options” menu and then tap “Move to”.

4. Tap the folder to which you want to move the e-mail message.

The selected e-mail message will be moved to the folder.

Note: Tap-and-holding the e-mail message in steps 2 and 3 will allow you to 
use a pop up menu.
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Other functions

Changing the view pattern
You can view the e-mail message in Text or Rich text format on the Examine screen. 

1. On the Examine screen, tap the “View” menu and then tap “Text format”.

The Text format will be unchecked and the Examine screen will be displayed in 
Rich text format.

To return to the original mode, repeat step 1.

Changing the e-mail status
You can change the e-mail status for received or sent messages.

1. On the Examine screen, tap the “Mail” menu.

2. Tap “Set status” and then tap “Sent” or “Unsent” for a sent e-mail message, or 
tap “Unread” for a received e-mail message.

Switching the e-mail message to view
While displaying the Examine screen, you can switch e-mail messages.

1. Tap  or  on the Examine mail screen. 
Or tap the “View” menu and then tap “Previous” or “Next”.
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Extras

City Time
The City Time application shows you six world times you can choose at any time.

1. In the Applications folder of the Home screen, tap the “City Time” application 
icon.

The City Time screen will be displayed.

To change to other cities
1. Tap the City button that you want to change.

The Select City screen appears listing the region’s name in alphabetical order 
in the left list, and its main city names in the right list.

Time Zone Map

City buttons
Date indicators

Magnification button ( )

Night zone

Daytime zone
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Note: To find the desired region’s name, press the first character of the 
region’s name on the hardware keyboard. The focus moves to the 
matching region’s name.  

2. Tap the desired region’s name and then the city name.

3. Tap  on the Select City screen.

The selected city name appears on the button you have tapped in step 1, and 
the setting will be saved. 

To change to other cities using the zone map
1. Tap the City button that you want to change. 

The Select City screen appears. 

2. Tap the “Go to Zone Map” button. 

3. Tap and drag the stylus anywhere on the Time Zone Map or press to move 
the focus until the desired city name appears. 

If you want to magnify the map to find the city name precisely, tap the 
Magnification button ( ). Tap it again to return the original size.

4. When you find it, press the SELECT key or  immediately while the pop-up 
window of the city name is displayed. 

The city name on the button will change to that selected on the Time Zone Map, and 
the setting will be saved.
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Clock
The Clock application shows the current time and date and can be used as a 
stopwatch.

1. In the Applications folder of the Home screen, tap the “Clock” application icon. 

The Clock screen appears.

Be sure to confirm beforehand the current date and time is set correctly in the Date/
Time application in the Settings folder.

Using a Stopwatch
1. Tap the Stopwatch mode radio button to switch to stopwatch mode.

2. Tap the “Start” button to start (or resume) the stopwatch, and tap the “Stop” 
button to stop it. While the stopwatch is running, it displays hour, minute, and 
second. When it stops, a hundredth of a second is also displayed.

3. Tap the “Reset” button to set the time back to zero.

4. Tap the Clock mode radio button to return to clock mode.

Clock mode radio button
Stopwatch mode

radio button

Start (Stop) button
Reset button
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Calculator
The Calculator application allows you to perform mathematical operations, including 
Euro conversions. It functions in exactly the same way as a standard calculator.

Note: Be sure to tap “C·CE” before starting calculations. 

1. In the Applications folder of the Home screen, tap the “Calculator” application 
icon.

The Calculator screen appears.

2. Perform the calculation by tapping the numeric and mathematical symbol keys 
on the screen.

Note:

• Should you enter a wrong equation (+, -, x, etc.), be sure to enter the correct 
equation after the wrong equation.

• Be sure to tap “C·CE” before performing the next calculation.  

Using the Euro conversion mode
In the Conversion mode, you can make conversions using the Euro currency 
symbol.

“+/-” button
Changes a positive 
number to a negative 
number and vice 
versa.

“M-” button
Subtracts a number 
from the memory.“R.CM” button

Displays the memory’s 
content, and tapping it 
twice clears the 
memory.

Conv./Calc button
Switches the calculation 
mode between standard 
and conversion mode.
This button toggles 
between Conv. and Calc 
every time the button is 
tapped.

“C.CE” button
Clears the number 
entered last, and tapping 
it twice clears the current 
calculation.

“M+” button
Adds a number to the 
memory.
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1. Tap “Conv”. to set the conversion rate for the Euro.

The on-screen keyboard changes to the conversion layout.

2. Tap “Rate” and then enter the rate for 1 Euro.

3. Tap “Rate” to save the setting.

Note: To change the rate, repeat steps 1 through 3.

4. Enter the value on the Calculator screen by tapping the digit keys.

5. Tap the conversion type (  ,  ).

The conversion result will be displayed on the screen.

Note: Conversion result is approximate, because the result is rounded up or 
down. 

When an error message appears
When the error indicator is displayed and the current calculation is suspended, tap 
the “C·CE” button to clear the error.
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System Info
This application presents a set of tabbed folders each presenting a different aspect 
of the system’s state.

1. In the Applications folder of the Home screen, tap the “System Info” application 
icon.

The System Information screen appears.     

2. Tap the desired tab.

3. Tap  to close the application.

Note: In the Memory folder, the memory indicator may vary depending on the 
status before the unit is turned off, and when the unit is turned off and 
then turned back on. This is because the memory counts the memory 
size used for internal purposes as well. 

“Memory” 
folder

Shows memory usage.

“Storage” 
folder

Shows storage usage.
Shows main storage usage.
If a memory card is inserted into the unit, the memory card 
information will be added on the screen. 

“CPU” folder Shows the processor and its power while performing application 
tasks and system tasks.

“Version” 
folder

Provides information on the system’s software.
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Voice Recorder (commercially available)
By attaching the commercially available microphone to the stereo headphone jack, 
you can record voice. 

Attaching the microphone
1. Attach the microphone to the stereo headphone jack, until it locks into place.

Overview

Control screen
1. In the Applications folder of the Home screen, tap the “Voice Recorder” 

application icon.

The Index screen appears.
Stop icon
Play icon
Rewind icon
Forward iconFile menu

Options menu

Recording/Playback 
time slider

Title button

Date button

Record icon

Trash icon
Recording/Playback 
time indicator

Media button
Time button

Status indicator
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• Recorded images can also be saved on the expansion memory card directly. 
Recorded time is approximately one hour if only voice is to be recorded excluding 
data created by other built-in applications, add-on software, etc.

File menu
Record Starts recording.
Stop Stops recording or playback.
Play Plays back the selected file.
Rew Rewinds for a fifth seconds of the total playback time by 

tapping once.
FF Advances a fifth seconds of the total playback time by 

tapping once.
Rename Renames the selected file. Up to 100 character spaces are 

available.
Delete… Deletes the selected file.
Delete all… Deletes all files of this application.

Options menu
Preferences… Opens a screen to set up the Voice Recorder preferences.
Help… Opens the on-line Help screen.

Record icon Starts recording.
Stop icon Stops recording or playback.
Play icon Plays back the selected file.
Rewind icon Rewinds for a fifth seconds of the total playback time by 

tapping once.
Forward icon Advances a fifth seconds of the total playback time by 

tapping once.
Trash icon Deletes the selected file.
Status indicator Indicates a recording or playback status.
Recording/Playback 
time slider

Indicates a recording or playback time.

Recording/Playback 
time indicator

Indicates recording time/recordable time or playback time/
total playback time.

Title button Tap to sort entries by file name.
Date button Tap to sort entries by date.
Time button Tap to sort entries by recording time.
Media button Tap to sort entries by media.
File List area Lists the recorded files.
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Recording
1. Make sure that the microphone is attached.

2. In the Applications folder of the Home screen, tap the “Voice Recorder” 
application icon.

The Voice Recorder Index screen appears.

• If you want to record images on a CF or SD/MMC memory card, select it from 
the Preferences screen (See page 86).

3. Tap the Record icon.

4. To stop recording, tap the Stop icon or press the SELECT key.

Note:

• The recorded file will be saved in WAV format.
• The default file will be named as follows: recording, recording 2, recording 3,... 

If you want to rename the file, use the File menu. The slash (/), period (.) and 
currency symbols can not be used.

• During browsing of the Internet, transferring e-mail messages, or 
communicating with a PC, etc., recording is not possible.

• If memory space is lacking during recording, recording stops automatically. 
Try again after deleting unnecessary files.

• For the memory space less than the values listed below, recording will be 
canceled.

• Alarm setting will be disabled during recording.

Main memory:
CF card:
SD memory card:
(MMC)

512 kbyte
100 kbyte
100 kbyte

00.Cover.book  Page 85  Monday, January 21, 2002  5:47 PM



86 Extras

Playing
1. Attach the stereo headphone to the stereo headphone jack, until it locks into 

place.

2. On the Index screen, tap the desired record.

3. Tap the Play icon or press the SELECT key.

• To stop playback, tap the Stop icon or press the SELECT key.

Setting up the preferences
You can customize the saving or voice recording preferences.

1. On the Index screen, tap the “Options” menu and then tap “Preferences...”.

The Preferences screen appears.

2. Tap  to save the setting.

Save to Specify the destination.
If either the SD Card or CF Card is selected and the 
selected card is not in the slot, the destination will be 
automatically the internal memory.

Voice Recording 
format

Specify the compression rate in voice recording mode.

“Voice recording 
format” drop-down 
list button

Tap to select from the following:
• 22,050 Hz, 16Bit, Mono (352kbps)
• 16,000 Hz, 16Bit, Mono (256kbps)
• 11,025 Hz, 16Bit, Mono (176kbps)
•  8,000 Hz, 16Bit, Mono (128kbps)
• 22,050 Hz, 8Bit, Mono (176kbps)
• 16,000 Hz, 8Bit, Mono (128kbps)
• 11,025 Hz, 8Bit, Mono (88kbps)
•  8,000 Hz, 8Bit, Mono (64kbps)

Input Gain Adjustment 
slider

Adjust the input gain.

Save to

“Voice Recording format” 
drop-down list button

Input Gain Adjustment 
slider
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Help Browser
The Help Browser is a hypertext help system that works in a similar way to a Web 
browser.

1. In the Applications folder of the Home screen, tap the “Help Browser” icon. 

The top screen will be displayed.

2. Tap a blue word to jump to the page concerning the word.

Note: With the following methods, you can open the context-sensitive help 
screen of the Help Browser.
• Tap  for application help screen. (not available for all applications)
• Tap the "Options" menu and then tap "Help…" on the Index screen of  

applications. (not available for all applications)    

Registering bookmarks 
By registering frequently-used pages, you can jump to the page easily. You can 
register up to 12 bookmarks in the Help Browser application.

1. Display the Help Browser page you want to register to the bookmarks.

2. Tap the “Bookmarks” menu, and then tap “Add Bookmark”.
The title of the page will be registered.

Once you have registered it, the title of the bookmarked page will be displayed in the 
Bookmarks menu.

Bookmarks menu
Add Bookmark Adds the page to the bookmarks.
Remove from Bookmarks Removes registered bookmarks.

Bookmarks menu
Home icon
Forward icon
Backward icon
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Removing bookmarks
1. Tap the “Bookmarks” menu and select the bookmarked page that you want to 

remove from the menu.
The bookmarked page will be displayed.

2. Tap the “Bookmarks” menu, and then tap “Remove from Bookmarks”.
The bookmark of the page you are on will be removed from the bookmarks.
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Games
You can launch the following games from the “Games” folder of the Home screen. 
To exit each game, tap  or press .

 Asteroids
Destroy asteroids while avoiding collision.  
Press  to launch a new ship. Press  to move the ship. Press the SELECT 
key or the Space key on the keyboard to shoot. Press and hold  to make the ship 
move faster.
Press the Calendar key ( ) to start a new game.

 Go
Conquer more of the board than your opponent while avoiding capture. 
Tap the “Game” menu and then “New Game” to start. 
Tap an intersection on the board to place a stone. Tap the “Game” menu and then 
“Pass” to skip a turn. Tap the “Game” menu and then “Resign” to surrender. Tap the 
“Game” menu and then “Two player option” to play against an opponent. 

 Mindbreaker
Guess the sequence of the colored pegs. 
Start at the bottom. Tap and drag colored pegs to the holes in the wood block. Tap 
a peg to remove it from the wood block. When all holes are filled, tap the right side 
of the wood block to view the results. Each black or white pin means a peg has the 
right color. A black pin also means a peg is in the right position.
Tap  to start a new game. 
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 Mine Hunt
Quickly mark all the squares that contain mines. 
Select a game level of “Beginner”, “Advanced”, or “Expert” from the “Game” menu.
Tap and hold a square to mark (or unmark) it. Marked squares have a flag. Tap a 
square to clear it. Cleared squares show the number of mines in the surrounding 
squares.
Tap the yellow smiley face to start a new game.

 Patience
Sort the cards in their suits from Ace to King. 
Select “Patience” or “Freecell” from the “Play” menu. 
Tap and drag cards to the desired location. Tap the “Settings” menu and then 
“Change Card Backs” to change the image on the back of the cards. Tap the 
“Settings” menu and then “Snap To Position” to make cards snap into position. Tap 
the “Settings” menu and then “Turn Three Cards” to toggle between turning one or 
three cards at a time (Patience only).

 Snake
Make the snake grow longer by eating the mice. 
Press the SELECT key or  to start a new game.
Use  to guide the snake onto the mice. Do not hit the walls, edges or the snake’s 
tail. 

 Word Game
Use letters to form words and score points. 
Select player names from the comboboxes. Add a player to the list by typing the 
name in the combobox. 
Tap the “Start” button to begin a game. 
Tap and drag letters to the left to form words to place on the board. Tap the board 
and drag the stylus across the squares on the board where the word should go. Tap 

 to end your turn. Tap  to remove letters from the board. 
Tap  to end the game.
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Settings

Adjusting the date and time (Date/Time)
The date and time setting allows you to set the current time zone, date and time. For 
time-critical functions to work properly, the built-in clock application must be set to 
the current date and time. 

1. Tap the “Date/Time” application icon in the Settings folder of the Home screen, 
or tap the time indicator at the bottom right of the taskbar.

The Set System Time screen will be displayed.

2. Tap the Time Zone drop-down list button and select your time zone.

If your time zone does not appear in the drop-down list, tap the City Time button.

Note: The Time Zone drop-down list consists of 6 city names set using the City 
Time application. If your time zone is not found in the drop-down list, set 
it in the City Time application.

3. Tap the Time format drop-down list button and tap either of the choices: 12 hour 
or 24 hour.

4. Tap the up and down arrows on the Hour and Minute spinboxes to set the 
correct time.

If you select the 12-hour format in step 3, select AM or PM by tapping the drop-
down list.

Weeks start on drop-down 
list button

Time Zone drop-down list 
button
City Time button

Time format drop-down list 
button 

Date button

Date format drop-down list 
button

Hour and Minute
spinboxes
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5. Tap the Date button and then tap your current date on the Calendar screen that 
appears.

• Tap the up and down arrows of the year spinbox to set the current year.
• Tap the month drop-down list button and select the current month.
• Tap  or  to change the setting month by month.
• Tap  or  to select the first month (January) or last month (December) in 

one go. 
6. Tap the Weeks start on drop-down list button and then tap the starting day of 

the week of the calendar: Sunday or Monday.

7. Tap the Date Format drop-down list button and then tap the desired format.

The selected format applies to the Date column displayed on the Index screen 
of the application, etc.
M/D/Y (example, 12/26/02)
D.M.Y (example, 26.12.02)
Y-M-D (example, 02-12-26)
D/M/Y (example, 26/12/02)

8. Tap  to save the new date and time setting.

Note: To move the cursor from steps 2 through 7, press the Tab key as 
required on the hardware keyboard.
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Add/Remove Software
You can install applications (Linux/Qt/Java) downloaded from the Internet or created  
by yourself to the SL-5500. These applications must be packaged in ipkg format 
(*.ipk).
You can also remove these applications and make space for other applications or 
data. 

Overview
On the Add/Remove Select screen, you can select whether to install applications or 
to uninstall them. You can also select the method of installation.

1. In the Settings folder of the Home screen, tap the “Add/Remove Software” 
application icon.

The Add/Remove Select screen appears.

“Install packages via 
networks” button

Tap to install/uninstall applications via networks.

“Install packages” button
Tap to install applications from the expansion 
memory card or the Documents folder of the Home 
screen.

“Uninstall packages” button Tap to uninstall applications.

“Install packages via 
networks” button

“Install packages” 
button

“Uninstall packages” 
button
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Installing Package files
1. Insert the expansion memory card including the application package files into 

the expansion card slot.

2. On the Add/Remove Select screen, tap the “Install packages” button.

The Index screen for file installation appears displaying the list of application 
packages.

Note: By tapping the Package button, you can sort package files by name.

3. Tap the package file you want to install.

Or move the focus to the package file you want to install and then tap the 
“Install” button.

The Select Install Storage screen appears.

4. Tap the radio button of the storage medium (RAM, CF or SD) you want to install 
the package files to, and then tap  to execute the installation.

The display turns to the Index screen with the “installed” package icon.

If you tap , the installation is canceled.

5. Tap  twice to close the Add/Remove Software application to restart the SL-
5500.

The unit will then be automatically restarted.

The installed application package file is listed in alphabetical order in the related 
folder of the Home screen, and can be launched from there.

Note: If an error message appears during installation, follow the instructions  
displayed on the screen.

“Install” button

Icons
: not installed
: installed

Package button
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Installing Package files via networks
Be sure to set up dial-up or LAN preferences before installing application package 
files via networks. (See page 113.)

Index screen for installation via networks
1. On the Add/Remove Select screen, tap the “Install packages via networks” 

button.

The Index screen for installation via networks appears.

“Upgrade” button Updates the package information.
Server Setting icon Displays the Package Servers screen where you can set up 

the servers/proxy servers and select a server.
Package Search icon Displays the Search Packages screen where you can enter 

a keyword and search for it from the package list.
Package Information 
icon

Displays the Detail screen of the package information.

“Upgrade” button

Server Setting icon

Package Search icon

Package Information icon

Progress bar
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Server setup
Configure the server from which you want to install package files. 

1. On the Index screen for installation via networks, tap the Server Setting icon.

The Package Servers screen appears.

2. If you want to connect to a new server, tap the “New” button and enter the server 
name etc. in each field.

3. Select the server you want to connect to from the Servers list.

4. Tap  to connect to the selected server.

The Package Servers screen turns to the Index screen.

If you tap , the server setting is canceled.

Installing package files via networks
The list of application package files from the network appears.

Servers list

“New” button

“Remove” button
Removes the selected 
server from the list.

Server name field
URL of the server field

Proxy server for HTTP
connection field Login name for the 

proxy server fieldProxy server for FTP
connection field Login password for the 

proxy server field

Icons
: intended to be installed
: not installed
: installed
: intended to be removed

Package button Size button

Description button
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1. On the Index screen, double-tap the package file you want to install.
Or move the focus to the package file you want to install and then tap the 
Package Information icon ( ).

The Package information screen appears.

2. Tap the “Install” button.

The Package information screen turns to the Index screen.

The package file is now ready to be installed and the icon on the Index screen 
turns to .

If you tap , the icon turns to , and the package file will not be installed.

Note:

• You can also make the application package file ready to be installed without 
opening the Package information screen by tapping the “not installed” icon 
( ) you want to install.

• If you want to install several package files, repeat steps 1 and 2.

3. Tap .

The Select Install Storage screen appears.

4. Tap the radio button of the storage (RAM, CF or SD) you want to install the 
packages to.

5. On the Select Install Storage screen that appears, tap  to execute the 
installation.

The display turns to the Add/Remove Select screen.

If you tap , the installation is canceled.

“Install” button

“Remove” button
Makes this package 
ready to be removed.

“Ignore” button
Ignores this package 
and returns to the 
Index screen.
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6. Tap  to close the Add/Remove Software application to restart the SL-5500.

The unit will then be automatically restarted.

The installed application package is listed in alphabetical order in the related 
folder of the Home screen and can be launched from there.

Note: If an error message appears during installation, follow the instructions  
displayed on the screen.

Searching for a package file
You can search for a desired application package file by keyword.

1. On the Index screen for installation via networks, tap the Package Search icon 
( ).

The Search Packages screen appears.

2. Enter a word you want to find, then tap . 

Searching starts.

The Package information screen for package files found will be displayed. 
If multiple matching files are found, the information screen of the first entry on 
the Index screen will be displayed.
If you tap , the display returns to the Index screen where the matching files 
are highlighted. 
If not found, the display returns to the Index screen. 

If you tap , searching is canceled.
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Uninstalling package files
If you uninstall a package file, all information about the application, such as data and 
settings, are also deleted.

1. On the Add/Remove Select screen, tap the “Uninstall packages” button.

The Index screen for uninstallation appears.

2. Tap the package file you want to uninstall.
Or move the focus to the package file you want to uninstall and then tap the 
“Uninstall” button.

The confirmation message appears before the package is uninstalled.

3. Tap “Yes” to uninstall it.

If you tap “Cancel”, the uninstallation is canceled.

The uninstalled package disappears from the Index screen.

4. Tap  twice to close the Add/Remove Software application to restart the SL-
5500.

The unit will then be automatically restarted.
The application icon will disappear from the related folder of the Home screen.

Removing applications installed via networks
The Index screen for installation via networks allows you to remove applications.

1. On the Index screen, double-tap the package file you want to remove.
Or move the focus to the package file you want to remove and then tap the 
Package Information icon.

“Uninstall” button
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2. On the Package Information screen, tap the “Remove” button.

The Package Information screen turns to the Index screen.

The package file is now ready to be removed and the icon on the Index screen 
turns to . 

Note: On the Index screen, tap the “installed” icon ( ) you want to remove 
instead of performing steps 1 and 2 above.

3. Tap  to execute the removal.

The Index screen turns to the Add/Remove Select screen.

4. Tap  to close the Add/Remove Software application to restart the SL-5500.

The unit will then be automatically restarted.

The application icon will disappear from the related folder of the Home screen.

Backup/Restore
The Backup/Restore application allows you to make a backup file of the SL-5500’s 
data on an expansion memory card, or to restore it back to the internal memory of 
the SL-5500.
The expansion memory card needs 4 Mbyte - 32 Mbyte space (depending on the file 
size to be backed up) or more.

Caution:

• Be sure to use the AC adapter, not the battery pack, to carry out the backup 
and restore process. The backup and restore process cannot be carried out if 
the battery is exhausted.

• Be sure to save the current editing data and close all applications before 
carrying out the backup and restore process. 

• Do not press any key, tap the screen, or remove the expansion memory card 
during the backup and restore process.

• The passcode entered for security will also be backed up and restored.

Backup
1. With the SL-5500 turned on, insert the expansion memory card into the card 

slot. 

2. In the Settings folder of the Home screen, tap the “Backup Restore” application 
icon.

00.Cover.book  Page 100  Monday, January 21, 2002  5:47 PM



Settings 101

The Backup/Restore screen appears.

3. In the Backup/Restore options, tap the Backup radio button.

4. Tap the desired destination (CD or SD) in the Media option.

5. Tap “Start”. 

The confirmation message appears. 

6. Tap “Yes” to start backup process. 

When the backup process has been completed, the display will turn to the Home 
screen after a while. 
The backup file will be automatically named in the format of “yyyy-mm-dd-mm-
ss.backup”, for example, “2002-12-26-11-45.backup."

Restore

Caution: Restoring backup files will overwrite all files and passcode.

1. With the SL-5500 turned on, insert the expansion memory card that includes the 
backup files into the card slot. 

2. In the Settings folder of the Home screen, tap the “Backup Restore” application 
icon.

The Backup/Restore screen appears.

3. In the Backup/Restore options, tap the Restore radio button.

4.  Tap the destination inserted in step 1 above in the Media option.

5. Tap the drop-down list button and then tap the import file. 

6. Tap “Start”.  

The confirmation message appears.
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7. Tap "Yes" to start restore process.

When the restore process has been completed, the unit will automatically restarted 
and the display returns to the Home screen.

Beam Receive
You can transfer a single entry created in the Address Book, Calendar, or Todo List 
applications or a document file using the IR port (IrDA) on the left side of the unit.
This section describes how to transfer data between the same models. The SL-5500 
can transfer data with other models.

Note: Beaming items to models other than SL-5500 may cause loss of some 
items or character strings.

Setting
When you transfer data by infrared beam, be sure to turn the IR port to face that of 
the other unit and to use both units within 8 inches (approximately 20 cm of each 
other).

Beam Receive screen
The Beam Receive screen allows you to set up preferences for IR communication.

1. In the Settings folder of the Home screen, tap the “Beam Receive” application 
icon.

Not more than 8 inches 
(approximately 20 cm)
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The Beam Receive screen appears.  

  

Selecting the receiving mode
1. In the Settings folder of the Home screen, tap the “Beam Receive” application 

icon.

The Beam Receive screen appears.

2. Tap the desired receiving mode (Manual, Automatic).

3. Tap  to save the setting.

The setting will be effective immediately.

Beam receive mode
Manual radio button When checked, the unit receives data in manual mode.

In this mode, the Beam reception mode screen appears 
as the unit receives data. The unit enters receiving 
standby mode when you tap the “Start” button.

Automatic radio 
button

When checked, the unit receives data in automatic mode.
The unit starts receiving data any time the other unit 
sends data and the receiving unit detects a signal.

Manual beam receive
Start/Stop button Tap to start/stop the IR communication for manual beam 

receive.

Beam receive mode 
Manual radio button 
(recommended)
Automatic radio button

Manual beam receive
Start/Stop button
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Note: The Automatic-receiving mode consumes more battery power than the 
Manual-receiving mode, because the IR port is always in receiving mode 
to be set to Manual-receiving mode, when the IR port is not in use.

Transferring data between the same models (SL-5500) 

Receiving data in Manual mode
1. (in the receiving unit)

In the Settings folder of the Home screen, tap the “Beam Receive” application 
icon.

The Beam Receive screen appears.

2. Tap the Manual radio button and then tap “Start” to enter receiving standby 
mode.

3. Point the IR ports of both units at each other.

4. (in the sending unit)
To send an application entry

Open the Detail screen you want to send.

Then, tap the “Data” menu and then tap “Send by beam…”.

The entry will be transferred.

To send a document file

Tap and hold the desired document file icon in the Documents folder, and then 
on the Details screen that appears, tap “Beam”.

The document file will be transferred.

(in the sending unit)
To cancel sending on the way, tap “Cancel”.

(in the receiving unit)
After a while, the Beam Receive screen turns to the infrared receive screen.
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During reception of the data, the “Receiving...” message appears on the screen 
and the “Add” button becomes ineffective (grayed out).

5. When the reception of the data is complete, tap the “Add” button on the Infrared 
receive screen.

The received data will be added to the specified application or Documents folder 
of the receiving unit.

If you tap “Cancel”, the registration is canceled.

6. Tap the “Beam Receive” application icon displayed on the taskbar to display the 
Beam Receive screen, and tap the “Stop” button to cancel receive standby 
mode.

Note:

• Be sure to tap the “Stop” button in step 6. Otherwise, the battery, if it is used, 
will be exhausted to be in Standby mode.

• If the unit receives the data, which has the same category but belong to the 
different application, from the sending unit, the category of the received data 
will be changed to “Unfiled”.

File information Displays the file information (File name, type and size).
Information of the 
received entry

Displays the simple description of the application entry 
received.

Add button Adds the received data to the application (or Documents 
folder) of the receiving unit. When the reception of the data 
is complete, the “Add” button becomes effective.

Cancel button Tap to cancel registration of the received data.

File information

Add button

Information of the
received entry
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• The approximate time of file transfer is one minute per 100 Kbyte file.

Receiving data in Automatic receive mode
The Automatic receive mode notifies you of the data, even if you are in another 
application.

1. Tap the Automatic radio button on the Beam Receive screen.

2. Perform step 3 to 5 above of “Receiving data in Manual mode” to start data 
transfer.

Note: If the unit receives the data, which has the same category but belong to 
the different application, from the sending unit, the category of the 
received data will be changed to “Unfiled”.

Setting the Appearance
Appearance setting allows you to customize the desktop and window properties.

1. In the Settings folder of the Home screen, tap the “Appearance” application 
icon.

A list of styles and a list of color schemes appear.

2. Tap any of the three styles for the graphical display from the upper list.

3. Tap any of the seven-color schemes for the display from the lower list.

4. Tap  to save the settings.

The settings will be immediately effective.

The shape and design color of the button, scroll bar, drop-down list button, etc. 
will be changed.

To cancel setting, tap .
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Using the Application Key
The Application Key application allows you to assign the following four keys on the 
slide cover to any of the applications installed in the unit: Calendar key, Address 
Book key, Menu Popup key, EMail key.

Overview

Set Application Key screen
1. In the Settings folder of the Home screen, tap the “Application Key” application 

icon.

The Set Application Key screen appears.

2. Tap each drop-down list button to select the desired application name.

3. Tap  to save the setting.

The settings will be effective immediately.

Note: If you assign the Menu Popup key to other application keys, it will not be 
effective in each application as the Menu Popup key. In this case, carry 
out the tap operation for menu operation.

Drop-down list buttons
List all names of 
the applications 
installed in the unit.

00.Cover.book  Page 107  Monday, January 21, 2002  5:47 PM



108 Settings

Managing power (Light & Power)
Light & Power setting allows you to manage the frontlight and auto-power off feature. 

1. In the Settings folder of the Home screen, tap the “Light & Power” application 
icon.

2. Set the following items.

For the Power saving options, tap the checkbox and then tap the up or down arrow 
button of the spinbox to set the desired time.   

Dim light after When checked, the frontlight will be dimmed if no operation is 
performed in the specified time. The frontlight will turn on again 
if you resume operation.

Light off after When checked, the frontlight will turn off if no operation is 
performed in the  specified time.
If the “Dim light after” option is also checked, the frontlight will 
turn off after the specified time after the frontlight is dimmed. 
The frontlight will turn on again if you resume operation.

Suspend after The power will turn off if no operation is performed in the 
specified time. 
If the two above options are also checked, the unit will suspend 
after the specified time after the frontlight turns off.
This option cannot be turned off and does not function in the 
following cases:
• During slideshow of image files by the Image Viewer 

application.
• During playback of music files and viewing of video files by 

the Media Player application
• During file transfer by the Beam Receive application
• While the Stopwatch of the Clock application is running
• When the AC adapter is connected to the unit.

Brightness control slider

Dim light after checkbox
Light off after checkbox
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3. Tap  to save the setting, or tap  to cancel.

 Adjusting the touch panel (Recalibrate)
Calibration setting allows you to calibrate the screen.

To ensure that your SL-5500 correctly matches the positions you tap on the screen 
with the screen’s contents you may occasionally need to recalibrate.

1. In the Settings folder of the Home screen, tap the “Recalibrate” application icon.

The screen will change and show a cross near the bottom left of the screen. 

2. Press the stylus in the center of the cross, hold for a moment, then release. 

The cross will then move to another position. 

3. Press, hold and release once again. 

4. Repeat this process until recalibration automatically finishes.

Security
The Security application allows you to set your own passcode to protect your unit 
from unauthorized use.
Once you set the passcode and enable the setting, enter it every time you turn the 
unit on.

Caution:  Use this function with care. If you forget your passcode, you need to 
carry out the FULL reset. It will lose all data created and saved and 
add-on programs added to the unit. For detailed information on how 
to carry out FULL reset, refer to the separate Start-up Guide.

Brightness 
control slider

Move the slider to change the brightness of the frontlight. The 
actual brightness can be confirmed as you adjust the slider 
when the front light is turned on (which can be carried out by 
pressing the Front light key).
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Overview
1. In the Settings folder of the Home screen, tap the “Security” application icon.

The Security Settings screen will be displayed.

Note: If you have set the passcode in the initial settings after you have carried 
out a FULL reset or in this application, the passcode entry screen 
appears. 

Setting the passcode
By default, the passcode is not registered. Use the on-screen-numeric keyboard to 
enter the passcode.

1. Tap the “Set passcode” button.

2. Enter your passcode.

The passcode you enter will be replaced with “*” for your security.

3. Tap “OK”.

To cancel setting, tap .

4. Enter the same passcode again.

5. Tap “OK”.

You return to the Security Settings screen.

6. Tap  on the Security Settings screen to save the passcode.

Clear passcode button
Require pass code at

power-on checkbox

Set passcode button
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Changing the passcode
1. Tap the “Change passcode” button.

2. Enter your passcode and then tap “OK”.

3. Enter the new passcode and then tap “OK”.

You return to the Security Settings screen.

4. Tap  on the Security Settings screen to save the passcode.

Clearing the passcode
1. Tap the “Clear passcode” button and then tap   .

Turning the Security setting on or off
1. Tap the “Require pass code at power-on” checkbox to turn Security setting on.

2. Tap  on the Security Settings screen to save the passcode.

Entering the passcode at startup
When the “Require pass code at power-on” checkbox is turned on, you need to enter 
the passcode at startup.

1. Enter the passcode at startup.

The passcode you enter will be replaced with “*” for your security.

2. Tap “OK”.

The Home screen will be displayed and then you can start operation.

Note: If you enter the incorrect password, the screen will remain as the 
Passcode Entry screen and the Home screen will not be displayed.
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Shutting down
The Shutdown application allows you to restart the Linux system and the Qtopia 
system.
Restarting systems will erase data being edited.

Overview

1. In the Settings folder of the Home screen, tap the “Shutdown” application icon.    

Restart Qtopia button Restarts the Qtopia system.
Reboot button Resets the SL-5500.

The progress bar reaches 100% and then the Home 
screen will be displayed after approximately 20 
seconds.

Terminate Qtopia button Terminates and then launches the Qtopia system 
automatically.

Cancel button Cancels the functions above.

Restart Qtopia button
Reboot button Terminate Qtopia button
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Internet Settings

Internet Wizard
By following the on-screen instructions of the Internet Wizard application, you can 
set up dial-up and LAN preferences for both the EMail and Network & Sync 
applications.
• Dial-up - PPP: for dial-up connection using a modem card (CF type) and 

ordinary telephone line;
• LAN - TCP/IP: for local area network connection using a LAN card (CF type).

Overview
1. In the Settings folder of the Home screen, tap the “Internet Wizard” application 

icon.
The Internet Setting Wizard screen appears.

This screen allows you to check the current connection settings, edit them, etc. 

Current Connection
LAN field Displays the current setting selected for LAN-TCP/IP. 

When no setting is registered, “Not Specified” is 
displayed instead.

Dial-up field Displays the current setting selected for Dial-up - PPP. 
When no setting is registered, “Not Specified” is 
displayed instead.

LAN field
Dial-up field

New button
Copy button
Edit button
Delete button

Select Connection 
drop-down list 
button
Connection 
Information area

Switch Connection button
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Select Connection options
Select Connection 
drop-down list 
button

Lists all settings created for LAN/Dial-up. Tap to select 
the desired one.

Connection 
Information area

Displays information concerning the current setting listed 
in the Select Connection drop-down list button above.
This area lists the following.
For the current LAN settings
• Connection type (LAN)
• Connection media (LAN Card, USB)
• IP address (Obtain TCP/IP Information Automatically, 

Specify TCP/IP Information)
• Proxy setting (No proxies, Auto configure proxies, 

Set proxies) 
• Mail settings (Set, None)
For Dial-up settings
• Connection type (Dial-up)
• Modem type (Card Modem, Wireless Modem, IR)
• Dial type (Tone, Pulse)
• Telephone number of ISP
• Proxy setting (No proxies, Auto configure proxies, 

Set proxies) 
• Mail settings (Set, None)

New button Opens a screen for creating a new connection.
Copy button Opens a screen for creating a new connection using a 

duplicate of the current setting in Select Connection.
Edit button Opens a screen for editing the current setting in the 

Select Connection.
Delete button Deletes the current setting in Select Connection.
Switch Connection 
button

If multiple connection settings are created, tap to set the 
current setting in Select Connection to the current 
connection.
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Creating a new LAN setting
1. On the Internet Setting Wizard screen, tap “New”.

The New Connection screen appears.  

2. Tap the “LAN” radio button for “Select the connection type”.

3. If you do not want to set up e-mail preferences now, tap the Make mail setting 
checkbox to uncheck.

4. Tap “Next”.

Fill out the following screens according to your connection type.

If necessary, tap “Back” on the following screens to modify settings on the 
previous screen.

Connection type radio 
buttons

Select the connection type.

Make mail setting 
checkbox

Check if you want to set up e-mail preferences.

Back button Moves to previous screen, if available.
Next button Moves to the next screen (for dial-up or LAN) after saving 

settings made on the current screen.

Connection type 
radio buttons

Back button

Next button

Make mail setting 
checkbox
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The first screen appears. 

Connection Name field Enter the desired connection name to be displayed in the 
Select Connection drop-down list on the Internet Setting 
Wizard screen.

Connect by radio 
buttons

Select the connection type (Card or USB).

Network
“Obtain IP address 
Automatically” 
checkbox

When checked, the IP address is automatically obtained 
from the Dynamic Host Configuration Protocol (DHCP) 
server.

IP Address Enter the IP Address, if necessary.
Dimmed if the “Obtain IP Address automatically” is 
selected.

Subnet Mask Enter the subnet mask, if necessary.
Dimmed if the “Obtain IP Address automatically” is 
selected.

Gateway Enter the Gateway address, if necessary.
Dimmed if the “Obtain IP Address automatically” is 
selected.

“DNS...” button Opens the screen for setting DNS addresses (primary, 
secondary). Enter them, if necessary, and then tap  
to save them.

“Obtain IP address 
Automatically” 
checkbox

“DNS...” button

Connection Name field
“Connect by” radio 
buttons
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5. If necessary, tap “DNS...” and then enter the DNS addresses.

Then tap  to save the DNS addresses.

6. Tap “Next”.

The next screen for the Proxy setting appears.

7. Tap the Proxy drop-down list button and then tap the desired type.

There are three types of setting options.

No proxies

No proxies Select when you do not set a proxy server.
Auto configure proxies Select when you want a proxy server to be automatically 

selected.
Set Proxies Select when you set it manually.

Primary DNS field
Secondary DNS field

Proxy drop-down 
list button
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Auto configure proxies
Enter the URL for automatic proxy configuration in the Config field.

Set Proxies 

HTTP Proxy
Host Enter the URL for HTTP proxy server.
Port Enter the port number for HTTP proxy server. Tap the up 

or down arrow to change the port number.

FTP Proxy
Host Enter the URL for FTP proxy server.
Port Enter the port number for FTP proxy server. Tap the up or 

down arrow to change the port number.

No proxy for Enter the URL for which the proxy server is not required.
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8. Tap “Next”.

The next screen for e-mail settings appears, if you have checked the “Make mail 
setting” checkbox on the New Connection screen (p. 115). If you have not, the 
confirmation screen appears (step 9).  

Account Name field Enter the account name, which will be displayed in the 
Accounts menu of the EMail application.

User Name field Enter the login name used to log in to an e-mail server.
Save password 
checkbox

Check if you want to save the password. If checked, you 
need no password to log in to an e-mail server.

Password field Enter the password.
Dimmed if the “Save Password” checkbox is unchecked.

Account Type drop-
down list button

Select the receiving mail server type (POP or IMAP).

SMTP server field Enter the sending mail server.
POP/IMAP server field Enter the receiving mail server name.
Mail address field Enter the e-mail address.

Password field
Save password

checkbox
Account Type drop-down 
list button

User Name field
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9. Tap “Next”.

The confirmation screen appears.

10. Confirm the contents of the setting and then tap “Register” to save the setting.

The display turns to the main screen (Internet Setting Wizard screen).

Tapping the Select Connection drop-down list button displays the new LAN 
setting.

Creating a new dial-up setting
1. On the Internet Setting Wizard screen, tap “New”.

The New Connection screen appears.

2. Tap the “Dial-up (Telephone line)” radio button for “Select the connection type”.

3. If you do not  want  to set up e-mail preferences now, tap the Make mail setting 
checkbox to uncheck.

4. Tap “Next”.

Fill out the following screens according to your connection type.

If necessary, tap “Back” on the following screens to modify settings on the 
previous screen.

View area

Register button
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The first screen appears. 

Connection Name field Enter the desired connection name to be displayed in the 
Select Connection drop-down list on the Internet Setting 
Wizard screen.

Telephone Number 
field

Enter the telephone number.

Dial using radio 
buttons

Select the dial type (Tone or Pulse).

Modem type radio 
buttons

Select the modem type (Card or IR).

“Advanced Setting...” 
button

Opens the detailed screen for modem setting.

“Advanced Setting...” button

Connection Name field

Telephone Number field

Dial using radio buttons

Modem type radio buttons
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5. If necessary, tap the “Advanced Setting...” button to enter more settings.

The Advanced setting screen appears.     

6. Tap  to save the advanced settings.

7. Tap “Next”.

The second screen appears telling you to set the connection ID and connection 
password. 

AT-command 
combobox

Enter if you add a special modem command to the 
telephone number.

Speed drop-down list 
button

Select the communication speed.
Choices are:9600, 19200, 38400, 57600, and 115200.
The default setting (115200) is recommended unless you 
need to change it.

Hardware flow control 
checkbox

Check to perform hardware flow control. (default: ON) 
Leave it checked unless you need to change it.

Wait time slider Change the time-out for PPP connection by moving the 
slider, if necessary.

Wait time slider

AT-command combobox
Speed drop-down list 
button
Hardware flow control 
checkbox

Save Password 
checkbox

Connection ID field

Password field

Primary DNS field
Secondary DNS field

“Auto-detect name 
servers” checkbox
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8. Enter the necessary items and then tap “Next”.

The next screen for the Proxy setting appears.

9. Tap the Proxy drop-down list button and then tap the desired type.

There are three types of setting options.

No proxies

Connection ID field Enter your account.
Save Password 
checkbox

Check if you want to save the password. If checked, you 
need no password when dialing up.

Password field Enter the password.
Dimmed if the “Save Password” checkbox is unchecked.

“Auto-detect name 
servers” checkbox

Check if you want to set the DNS address assigned by the 
server.

Primary DNS field Enter the primary DNS address.
Dimmed if the “Auto-detect name servers” is selected.

Secondary DNS field Enter the secondary DNS address.
Dimmed if the “Auto-detect name servers” is selected.

No proxies Select when you do not set a proxy server.
Auto configure proxies Select when you want a proxy server to be automatically 

selected.
Set Proxies Select when you set it manually.

Proxy drop-down 
list button
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Auto configure proxies 
Enter the URL for automatic proxy configuration in the Config field.

Set Proxies 

HTTP Proxy
Host Enter the URL for HTTP proxy server.
Port Enter the port number for HTTP proxy server. Tap the up 

or down arrow to change the port number.

FTP Proxy
Host Enter the URL for FTP proxy server.
Port Enter the port number for FTP proxy server. Tap the up or 

down arrow to change the port number.

No proxy for Enter the URL for which the proxy server is not required. 
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10. Tap “Next”.

The next screen appears telling you to set up the e-mail settings if you have checked 
the “Make mail setting” checkbox on the New Connection screen (p. 115). If you 
have not, the confirmation screen appears (step 12).           

11. Enter the necessary items and then tap “Next”.

The confirmation screen appears.

12. Confirm the contents of the setting and then tap “Register” to save the setting.

The display turns to the main screen (Internet Setting Wizard screen).

Tapping the Select Connection drop-down list button displays the new dial-up 
setting.

Account Name field Enter the account name, which will be displayed in the 
Accounts menu of the EMail application.

User Name field Enter the login name used to log in to an e-mail server.

Save password 
checkbox

Check if you want to save the password. If checked, you 
need no password to log in to an e-mail server.

Password field Enter the password.
Dimmed if the “Save Password” checkbox is unchecked.

Account Type drop-
down list button

Select the receiving mail server type (POP or IMAP).

SMTP server field Enter the sending mail server.
POP/IMAP server field Enter the receiving mail server name.
Mail address field Enter the e-mail address.

Account Name field
User Name field
Password fieldSave password

checkbox
Account Type drop-down 
list button
SMTP server field
POP/IMAP server field
Mail address field
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Modifying settings
1. Open the Internet Setting Wizard screen.

2. Tap the Select Connection drop-down list button and then tap the desired 
setting.

3. Tap “Edit”.

4. Modify the setting.

For details on how to edit the setting, see section “Creating a new LAN (or dial-
up) setting”.

5. On the confirmation screen that appears, tap “Register” to save the 
modification.

Deleting settings
1. Open the Internet Setting Wizard screen.

2. Tap the Select Connection drop-down list button and then tap the desired 
setting.

3. Tap “Delete”.

The confinmation message appears.

4. Tap “Yes”.

The selected setting will be deleted.

Connecting or disconnecting

For LAN connection
1. When you have completed your settings, insert the LAN card into the CF card 

slot.
Be sure to insert the card with the unit turned on, and remove it using the Eject 
Operation. (See the separate Start-up Guide.)

2. In the Settings folder of the Home screen, launch the Internet Wizard 
application.

If multiple Network Services are available, tap the Select Connection drop-down 
list button and then tap the LAN setting.

3. Tap “Switch Connection” to establish the connection.
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For dial-up connection
1. When you have completed your settings, insert the modem card into the CF 

card slot.
Be sure to insert the card with the unit turned on, and remove it using the Eject 
Operation. (See the separate Start-up Guide.)

2. Tap the Connection Status icon ( ) on the taskbar.
The pop-up list for network connection appears.

3. Tap the drop-down list button to select the desired dial-up account if multiple 
dial-up accounts are available.

4. Tap “Connect” to start connection.

(While the connection is established, “Connect” turns to “Disconnect”.)

5. Tap “Disconnect” to disconnect the line.

Network & Sync
The Network & Sync application allows you to set up dial-up and LAN preferences, 
and IP address for USB or serial connection. The dial-up and LAN settings are 
effective for both the Network & Sync and Internet Wizard applications.
• Dial-up - PPP: for dial-up connection using a modem card (CF type) and 

ordinary telephone line
• IrDA - PPP: for dial-up connection using the IrDA port
• LAN - TCP/IP: for local area network connection using the LAN card (CF type)
• USB - TCP/IP: for local area network connection using the USB network
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1. In the Settings folder of the Home screen, tap the “Network & Sync” application 
icon.

The Network screen will be displayed consisting of three folders: 
Current, Services, and Sync.

Overview 

Current folder Displays the IP address of the current Network service for 
LAN connection for which you have established connection.
If multiple Network services for LAN connection are 
registered, switching can be made in this folder.

Services folder
Network service list Lists all settings.
“Add...” button Adds a new destination.
“Remove” button Deletes the selected destination.

Network Service list

“Add…” button
“Remove” button

“Properties” button

Current folder Services folder

Sync folder

Serial IP Address

USB IP Address

Apply button
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Note: For information on how to configure the USB or serial connection, see 
the separate on-line manuals, “Qtopia Desktop” or “Intellisync for SL”. 
Keep the default setting for normal use.

Creating a new setting
1. Tap “Add...” in the Services folder.

The Add Network Service screen will be displayed.

Setting up PPP preferences
By setting up the PPP preferences, you can connect to a telephone line to access 
the Internet.

Note: Specifying the IP address is not supported.

1. On the Add Network Service screen, tap “Dial-up - PPP” or  “IrDA - PPP” in the 
Network Service list and then tap “Add”.

“Properties” button Displays the properties of the network service selected in the 
list. On the screen that appears, you can edit settings.

Sync folder
USB IP Address Enter the IP address to be used for USB connection.
Serial IP Address Enter the IP address to be used for serial cable connection.
Apply button Tap to save the setting above.

Network Service list

Add button Cancel button
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The Dial-up (or IrDA) screen will be displayed consisting of four folders: 
Account, Modem, Network, and Proxies.

2. Set the necessary items in the Account folder.

3. Tap the “Modem” tab.

The Dial-up screen for modem options will be displayed.

Name field Change the name, if necessary. This name is displayed 
when you tap the Network Status icon on the taskbar.

Username field Enter the username used to establish connection.
Password field Enter the desired password used to establish connection

Phone field Enter the telephone number used to access the Internet 
Service Provider.

Name field

Username field
Password  field

Phone field

AT-dial combobox

Flow control checkbox
Wait time slider

Speed drop-down list button
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4. Set the necessary items.

5. Tap the “Network” tab.

The Dial-up screen for Network options will be displayed.

6. Set the necessary items.

AT-dial combobox Select your dial type: ATDT (tone) or ATDP (pulse). Or 
enter the arbitrary AT command, if necessary.

Speed drop-down list 
button

Select the communication speed.
The default setting (115200) is recommended, unless you 
need to change it.

Hardware flow control 
checkbox

Check to perform the hardware flow control. (default: ON) 
Leave it checked unless you need to change.

Wait time slider Change the time-out for PPP connection by moving the 
slider, if necessary.

Auto-detect name 
servers checkbox

Check if you want to set the DNS address assigned by the 
server.

First DNS field Enter the primary and secondary DNS by deselecting the 
Auto-detect name servers checkbox.Second DNS field

Auto-detect name
servers checkbox

First DNS field

Second DNS field
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7. Tap the “Proxies” tab.

The Dial-up screen for Proxies options will be displayed.

8. Tap the Proxy drop-down list button to select the method of setting the Proxy 
server.

9. Select according to your choice.

Auto configure proxies
Enter the URL for automatic proxy configuration in the Config combobox.

No proxies Select when you do not set a proxy server.
Auto configure proxies Select when you want a proxy server to be automatically 

selected.
Set proxies Select when you set it manually.

Proxy drop-down list
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Set proxies

10. Tap .

The new setting will be added to the Services folder.

Setting up network preferences
For LAN (or USB) preferences, consult your network administrator.

1. Tap “Add...” in the Services folder.

2. On the Add Network Service screen, tap “LAN - TCP/IP” or “USB - TCP/IP” and 
then tap “Add”.

HTTP Proxy 
Host Enter the URL for HTTP proxy server.
Port Enter the port number for HTTP proxy server.

FTP Proxy 
Host Enter the URL for FTP proxy server.
Port Enter the port number for FTP proxy server.

No proxies for Enter the URL for which the proxy server is not 
required.
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The LAN (or USB) screen will be displayed consisting of four folders: Account, 
TCP/IP, DNS, and Proxies.

3. Set the necessary items in the Account folder. 
Name field The default name of the network service will be displayed. 

Edit so you can easily distinguish when there are multiple 
settings. 

“Obtain TCP/IP 
Information 
Automatically” radio 
button

When checked, the IP address will be automatically 
obtained from the Dynamic Host Configuration Protocol 
(DHCP) server.
The TCP-IP and DNS tabs are dimmed.

“Specify TCP/IP 
Information” radio 
button

When checked, specify the IP address in the TCP/IP, DNS 
folder, etc.

Name field

“Obtain TCP/IP Information
Automatically” radio button

“Specify TCP/IP
Information” radio button
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4. Tap the “TCP/IP” tab and set the necessary items if you select the “Specify 
TCP/IP information” option in the Account folder.

5. Tap the “DNS” tab and set the necessary items if you select the “Specify 
TCP/IP information” option in the Account folder. 

IP Address field Input the IP address here.
Subnet Mask field Change the subnet mask here, if necessary.
Broadcast field Set the broadcast address, if necessary.
Gateway field Input the Gateway address.

Primary DNS field Input the primary DNS address. 
Second DNS field Input the secondary DNS address.

IP Address field
Subnet Mask field
Broadcast field
Gateway field

Primary DNS field
Second DNS field
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6. Tap the “Proxies” tab.

The Dial-up screen for Proxies options will be displayed.

7. Tap the Proxy drop-down list button to select the method of setting the Proxy 
server.

8. Select according to your choice.

Auto configure proxies
Enter the URL for automatic proxy configuration in the Config combobox.

No proxies Select when you do not set a proxy server.
Auto configure proxies Select when you want any proxy server to be 

automatically selected.
Set proxies Select when you set it manually.

Proxy drop-
down list button
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Set proxies

9. Tap .

The new setting will be added to the Services folder.

Modifying the settings

You can modify the current settings you want to modify in the Services folder.

1. Open the Services folder.

2. Tap the desired setting you want to modify from the list.

3. Tap “Properties”.

4. Modify, as you want by tapping any tab.

5. Tap  to save the modification.

HTTP Proxy 
Host Enter the URL for HTTP proxy server.
Port Enter the port number for HTTP proxy server.

FTP Proxy 
Host Enter the URL for FTP proxy server.
Port Enter the port number for FTP proxy server.

No proxies for Enter the URL for which the proxy server is not 
required.
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Deleting settings

1. Open the Services folder.

2. Tap the desired setting you want to delete from the list.

3. Tap “Remove”.

The confirmation message appears.

4. Tap “Yes”.

The selected setting will be deleted.

Proxim Configuration
This PROXIM Configuration application allows you to configure the OpenAir 
Wireless LAN card  (Harmony 7630 OpenAir™ CompactFlash™ Card) 
manufactured by Proxim. 
For the information of how to set each option, see also the instructions supplied to 
the product.

1. In the Settings folder of the Home screen, tap the “Proxim Configuration” 
application icon.

2. Enter the setting.

3. Tap  to save the setting.

Wireless LAN Setting
This Wireless LAN Setting application allows you to configure the wireless LAN card. 
The compatible wireless LAN card is LANEscape™ XI-800 Wireless CF+ Card (Z-
Com), etc.

Note:

• For information on how to set each option, also see the instructions supplied 
with the product

• For information on the compatible peripherals and accessories, 
visit our Web site.
USA: www.sharp-usa.com
Other countries: www.sharp-world.com

1. In the Settings folder of the Home screen, tap the “Wireless LAN Setting” 
application icon.
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The Index screen appears. There are two folders: Config and Wep.

2. Enter the setting.

3. Tap  to save the setting.

Config folder Wep folder
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Appendix

Connection Errors
Check the following if for some reason error messages are displayed when the line 
connection is established, or when the network error occurs.
• The device (modem card, LAN card, etc.) is connected correctly.
• The correct settings are made in the following applications: EMail, Network & 

Sync, Internet Wizard, Wireless LAN Setting, and Proxim Configuration.
• The username or password entered in the entry prompt may be incorrect. Enter 

the correct one again.

Note:

• Charge the battery to its full capacity when you establish the line connection.
• The telephone line can be terminated during data communication if the line 

quality is poor.

Memory Full Errors
If the memory is almost full, the unit may not function properly and display errors may 
appear in the instances listed below.

Should such errors occur, close any applications currently open or delete Document 
files no longer required, particularly large-volume files, such as music, video and 
image files according to the message that appears. Open the Details screen to view 
the relevant file information and then delete. (See page 142.)

Errors that can be caused by lack of memory:
• You are unable to create a new entry, delete an existing entry, or transmit (as a 

result of lack of memory).
• You are unable to copy or paste.
• You can not delete Address Book, Calendar or Todo List entries.
• Delays in operation occur, such as it taking longer than normal to switch between 

display screens and to display screens.
• Data you are editing is lost without saving if you attempt to operate other functions 

in the meantime and then return to the Edit screen.
• Data you are editing is lost without saving if you turn the unit off and then on again.
• Alarm setting is not executed.
• Certain other functions may also not operate properly.
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How to delete Document files using the Details screen
1. In the Documents folder of the Home screen, press and hold the stylus on the 

file icon you want to delete for a few moments.

The Details screen of the file will be displayed.

Caution: Be sure to check the location of the file to be deleted before deleting 
it, if the expansion memory card is inserted. Files stored on the 
expansion memory card can be deleted in the same way. Do this with 
care.

2. Tap “Delete” on the Details screen.

A confirmation message appears before the file is deleted.

3. Tap “Yes” to delete the file.

The file will be deleted.
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